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READ CAREFULLY BEFORE USING!
CANON SOFTWARE LICENSE AGREEMENT
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE
CD-ROM IN THIS BOX.  BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE
TERMS OF THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO
NOT USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN
THIS BOX (COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN
30 DAYS FROM THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A
REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and
conditions of this Agreement.

1.  LICENSE:  Canon grants you the non-exclusive right to use the SOFTWARE only on a
single computer.  You may physically transfer the SOFTWARE from one computer to
another provided that the SOFTWARE is used on only one computer at a time.  You shall
not install or use the SOFTWARE on a network, multiple CPU, multiple site arrangement,
or any other hardware configuration where the SOFTWARE is accessible to more than one
CPU or to more than one user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR
OTHERWISE USE, TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER
PROGRAMMING LANGUAGE, ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE
SOFTWARE, IN WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS
AGREEMENT.

2.  BACK-UP COPY:  You may make one copy of the SOFTWARE solely for back-up
purposes, or copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of
your computer and retain the original for back-up purposes.  Any other copying of the
SOFTWARE is a violation of this Agreement.  You must reproduce and include the
copyright notice on the back-up copy.

3.  SUPPORT AND UPDATES:  Canon is not responsible for providing maintenance or
support for use of the SOFTWARE.  No updates, fixes or support will be made available for
the SOFTWARE.

4.  LIMITED WARRANTY AND LIMITATION OF LIABILITY:  It is your responsibility to choose,
maintain and match the hardware and software components of your computer system.
Thus Canon does not guarantee uninterrupted service or correction of errors or that the
functions or performance of the SOFTWARE will meet your requirements.  THE
SOFTWARE IS LICENSED ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY
KIND. The CD-ROM storing the SOFTWARE is warranted only against defective material
under normal use for a period of ninety (90) days after purchase from an authorized Canon
dealer as evidenced by your sales receipt. Your sole remedy for a defective CD-ROM shall
be replacement of the same without charge when returned by you at your expense to your
point of purchase and proven to be defective upon inspection.  The replacement CD-ROM
will be warranted for the remainder of the original ninety (90) day warranty period of the
defective CD-ROM.  The limited warranty does not apply if the failure of the CD-ROM
resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend to
anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S



READ CAREFULLY BEFORE USING!

A-2

SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS
OR IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
IS LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT
LIMITATION, DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING
LOSS OF PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR
ARISING OUT OF THE SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5.  TERM:  This Agreement is effective upon your using the SOFTWARE and remains in effect
until expiration of all copyright interests in the SOFTWARE unless earlier terminated.  You
may terminate this Agreement by destroying the SOFTWARE.  This Agreement will also
terminate without notice to you if you fail to comply with any of the terms of this Agreement
and you must then promptly return the SOFTWARE.  In addition, Canon may enforce its
other legal rights.

6.  U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:  The SOFTWARE is provided with
restricted rights.  Use, duplication or disclosure is subject to restrictions as set forth in
either subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software
clause at DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial
Computer Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7.  SEVERABILITY:  In the event that any provision of this Agreement is declared or found to
be illegal by any court or tribunal of competent jurisdiction, such provision shall be null and
void with respect to the jurisdiction of that court or tribunal and all the remaining provisions
of this Agreement shall remain in full force and effect.

8.  CONTROLLING LAW:  The terms of this Agreement as it relates to purchases of the
Software in the United States of America shall be governed and construed in all respects in
accordance with the laws and regulations of the State of New York, without reference to
choice of law principles.  The terms of this Agreement as it relates to purchases of the
Software in Canada shall be governed by the laws of the province of Ontario.

9.  OWNERSHIP:  All rights, including but not limited to copyrights and trade secret rights, to
the SOFTWARE belong to Canon, its affiliated corporations and third party licensors.  Your
use of the SOFTWARE is subject to the United States, Canada and other applicable
copyright and trademark laws and nothing in this Agreement constitutes a waiver of the
rights of Canon, its affiliated corporations and third party licensors under such laws.
Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in
any images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT:  BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS.  YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND
CANON CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL
PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER
HEREOF.  NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS
SIGNED BY A DULY AUTHORIZED OFFICER OF CANON.
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● This manual consists of a chapter for Windows followed by a chapter for Macintosh.

In this manual, Windows XP Professional/Home Edition is referred to as Windows XP,
Windows Millennium Edition is referred to as Windows Me, Windows 2000 Professional is
referred to as Windows 2000, and Windows 98 Second Edition is referred to as Windows 98
SE.

● Where explanations are common to all operating systems, the screens used in the
examples are from Windows XP for Windows and from Mac OS X (10.2) for Macintosh.

● In this document, square brackets [ ] are used to indicate items such as button names and
icon names that appear on the computer screen.

● Numbers in parentheses in this document indicate reference pages.
● Descriptions of camera operations assume that the reader is familiar with the information

in the instructions supplied with the camera.
● For detailed information on how to use the software products and the restrictions that

apply to those products, refer also to the Help, Readme files and Software User Guide (A-
7) for the respective products.

● In order to transfer images from File Viewer Utility, you will need retouching (image
editing) software. In order to start the TWAIN Driver, you will need a TWAIN Driver-
compatible application. Explanations for transferring images from File Viewer Utility
described in these instructions and the explanations for TWAIN Driver-compatible
applications all use examples from Adobe Photoshop Elements 2.0.

● The explanations given below describe the type of content indicated by the respective
icons.

: Marks information that should be read before use to prevent problems that would
interfere with the functioning of software and computer.

: Marks additional information that you will find helpful.

Manual Organization, How to Read the

Warning

Do not play the supplied CD-ROM(s) in any CD-ROM Player that does not support data CD-ROMs. The
extremely loud sound that may result from playing the CD-ROM(s) in an audio CD player (music player)
could damage the speakers. It is also possible to suffer hearing losses from listening with headphones to
the loud sounds of a data CD-ROM played on a music CD player.

Safety Precautions
Please read the safety precautions carefully before using this product. Ensure that you use the
product correctly according to the procedures described in these instructions.
The following safety precautions are intended to instruct you in the safe and correct operation
of the product and its accessories to prevent injuries or damage to yourself, other persons and
property. Please read and ensure that you understand them before you proceed to the other
sections of these instructions.
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Install the software (W-3, M-3)

Connect the camera to your computer (W-9, M-7)

To work with the images

Start File Viewer Utility 
(W-16, M-14)

Display the images (W-20, M-18)

To take images from your computer

Start RemoteCapture 
(W-50, M-48)

Save the images on your computer 
(W-52, M-50)

Process the RAW images 
(W-29, M-27)

Save the images (W-36, M-34)

Operation Flow

● In addition, you can use the WIA Driver or TWAIN Driver (W-59) to quickly and easily
download JPEG images from your camera. You can also use ZoomBrowser EX (W-65) or
ImageBrowser (M-57) to produce ExifPrint-compatible prints and merge panoramic images.

● Descriptions of the software applications are provided in “Software” (A-5). Select the
application that best suits your purposes.

Trademark Acknowledgments
• Canon and EOS are trademarks of Canon Inc.
• Adobe and Photoshop are trademarks of Adobe Systems Incorporated.
• CompactFlash is a trademark of SanDisk Corporation.
• IBM is a registered trademark of International Business Machines Corporation.
• Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in

the United States and/or other countries.
• iBook, iMac and QuickTime are trademarks of Apple Computer Inc.
• Macintosh, PowerBook, Power Macintosh and FireWire are trademarks of Apple Computer

Inc., registered in the United States and other countries.
• Other names and products not mentioned above may be registered trademarks or

trademarks of their respective companies.

Manual and the Conventions Used
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This section briefly describes the main functions of the software provided on the bundled CD-
ROM.

■ EOS DIGITAL SOLUTION DISK
File Viewer Utility   Windows Macintosh

● Primarily for shooting RAW images and
recommended for users interested in
serious image processing.

● Can be used for displaying images as
thumbnails or single images saved on the
CF card in the camera, displaying and
processing RAW images, downloading
images to your computer and transferring
them to retouching software.

● Capable of rotating, protecting, saving,
deleting images and of printing image
indexes.

● Allows you to display and process RAW
images saved on your computer.

ZoomBrowser EX/PhotoRecord   Windows

ImageBrowser   Macintosh

● Primarily for shooting JPEG images and recommended for users who want an easy-to-use
program for displaying images as thumbnails or single images, downloading images to a
computer and printing the images in a range of different layouts.

● Provides straightforward image processing functions and simplifies the task of arranging
and organizing images.

● Can be used with the PhotoRecord print layout software to simplify a wide range of printing
tasks, including setting the size of the printed images, setting the layout, setting automatic
multi-image layout, selecting backgrounds and frames, and inserting titles and captions.

● Links with e-mail software to allow images to be sent as e-mail attachments.

Software
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RemoteCapture Windows Macintosh

● Enables you to control the camera from your computer to shoot single frames and take
images using the timer or interval timer.

● Allows you to download images directly to the computer.

WIA Driver Windows

● WIA Driver controls the communication between the camera and your computer.
● You must install WIA driver to use File Viewer Utility, ZoomBrowser EX or RemoteCapture

on Windows XP or Windows Me.
● Used simply, WIA Driver provides a simple way to download JPEG images in the [Scanner

and Camera Wizard] dialog box or Windows Explorer.

TWAIN Driver   Windows

● TWAIN Driver controls the communication between the camera and your computer.
● You must install TWAIN driver to use File Viewer Utility, ZoomBrowser EX or

RemoteCapture on Windows 2000 or Windows 98 SE.
● Used simply, TWAIN Driver allows you to display JPEG images saved on a CF card in the

camera and to transfer the images to a TWAIN Driver-compatible application.

PhotoStitch Windows Macintosh

● Automatically merges multiple images to provide a simple procedure for creating panorama
photos.
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PTP
PTP (Picture Transfer Protocol) is a standard protocol used for image transfer. PTP provides a
simple way of downloading digital camera images to a computer.
Your camera supports PTP. Because PTP is used as the image transfer protocol on your
camera, Windows XP users (using [Scanner and Camera Wizard]) and Mac OS X users (using
[Image Capture]) can quickly and easily download JPEG images simply by connecting the
camera to the computer, without having to start the software from the EOS DIGITAL
SOLUTION DISK.

■ Adobe Photoshop Elements 2.0 DISK
Photoshop Elements 2.0

● Full-featured retouching software equipped with a range of advanced image processing
functions.

ZoomBrowser EX/ImageBrowser Software User Guide
PDF format manuals providing more detailed explanations of the functions available in
ZoomBrowser EX and ImageBrowser are available on the Canon website. For URL
addresses*, please see the Canon Customer Support contacts in the Canon Limited Warranty
supplied with your camera.

* The PDF format manual is not available in some regions.

Adobe Acrobat Reader must be installed to read the PDF format manuals.
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Windows XP (Home Edition/Professional), Windows Me,
Windows 2000, Windows 98 SE

PC with one of the above OS preinstalled and a USB port as a standard
feature
* Upgraded machines not supported.

Windows XP: 300 MHz Pentium or better

Windows Me, 2000, 98 SE: 150 MHz Pentium or better

Windows XP: Minimum 256 MB required

Windows Me, 2000, 98 SE: Minimum 128 MB required

USB

File Viewer Utility: 100 MB or more,
RemoteCapture: 20 MB or more,
WIA Driver: 25 MB or more,
TWAIN Driver: 25 MB or more,
ZoomBrowser EX (including the PhotoRecord): 120 MB or more,
PhotoStitch: 40 MB or more,
Adobe Photoshop Elements 2.0: 350 MB or more

800 × 600 dots, High Color (16-bit color) or more required
1024 × 768 dots True Color (32-bit color) or more recommended

OS

Computer

CPU

RAM

Interface

Hard disk space

Display

● Depending on your computer system, this software may not run correctly on Windows 98.
Use the Windows 98 SE operating system or later.

● A CD-ROM drive is required for software installation.

The software bundled with this product runs on the systems described below.

Windows System Requirements

System Requirements
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System Requirements

Mac OS X (version 10.2 recommended),
Mac OS 9.0 to 9.2 (Mac OS 9.2 recommended)

Macintosh computer with one of the above OS installed and a USB
port as a standard feature
* Users of first-generation iMacs require a firmware update.

Power PC

Mac OS X: Minimum 256 MB required,
Mac OS 9.0 to 9.2: Minimum 128 MB required

USB

File Viewer Utility: 100 MB or more,
RemoteCapture: 15 MB or more,
ImageBrowser: 50 MB or more,
PhotoStitch: 30 MB or more,
Adobe Photoshop Elements 2.0: 400 MB or more

800 × 600 dots, 32,000 colors or more required
1024 × 768 dots or more recommended

OS

Computer

CPU

RAM

Interface

Hard disk space

Display

Macintosh System Requirements

● These software programs are not compatible with UFS (Unix File System) formatted disks
on Mac OS X.

● A CD-ROM drive is required for software installation.
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Where explanations are common to all operating systems, the screens used in the examples
are from Windows XP.

3 Working with Images in File
Viewer Utility ......................... W-15

Starting File Viewer Utility .................. W-16

Displaying Images ............................... W-20

Selecting Images ................................. W-21
Selecting Images with the Mouse .......W-21
Selecting Images from the Control
Panel ..................................................W-21

Selecting the Model-Specific Processing
Mode ..................................................... W-22

Selecting the Image Display Mode .... W-23
Selecting the Display Mode ................W-23
Selecting the Display Size ..................W-24
Checking the AF Point ........................ W-24
Showing/Hiding the Information Display
Frame of Thumbnail Images ............... W-25
Updating Information on Main
Window ...............................................W-25
Showing/Hiding Image Information .....W-25

Working with Selected Images .......... W-26
Protecting Images ...............................W-26
Selecting Images by Condition ...........W-26
Rotating Images .................................W-27
Erasing Images................................... W-27
Checking the Image Information and
Entering Comments ............................W-28
Printing Images................................... W-28

1 Installing the Software on Your
Computer ................................ W-3

Installing the Software on Windows .... W-4

Installing Photoshop Elements 2.0 ..... W-8
Please Register Your Camera! .............W-8

2 Getting Ready to Work with
Images ..................................... W-9

Setting the Communication Mode ..... W-10

Connecting the Camera to Your
Computer ............................................. W-11

Inserting a CF Card into Your Card
Reader .................................................. W-13

CF Card Folder Structure and File
Names ................................................W-13

Downloading JPEG Images Using
the PTP Function in Windows XP ...... W-14



Processing RAW Images .................... W-29
Modifying RAW Image Processing
Parameters .........................................W-29
Compensating the Brightness
(Digital Exposure Compensation) .......W-30
Adjusting the White Balance ..............W-31
Adjusting the Color in Images .............W-34
Adjusting the Sharpness .....................W-35
Specifying the Color Space ................W-35
Copying the Processing Parameters for
RAW Images ......................................W-35

Saving Images ..................................... W-36
Saving Images from the Camera to
Your Computer ................................... W-36
Extracting JPEG Images from RAW
Images ................................................W-38
Saving Images as an Index File .........W-40

Transferring Images to Retouching
Software ............................................... W-42

Specifying the Image Transfer
Settings ...............................................W-42
Transferring Images ...........................W-43

Specifying the Preferences ................ W-44

Specifying the Camera Settings ........ W-46

4 Operating the Camera from Your
Computer .............................. W-49

Starting RemoteCapture ..................... W-50

Using RemoteCapture ........................ W-52
Taking Shots from Your Computer ...... W-52
Timer Shooting ................................... W-53
Interval Timer Shooting .......................W-54
Checking Shooting Settings ............... W-54
Printing Images................................... W-54

Setting RemoteCapture ...................... W-55
Default Settings ..................................W-55
Detailed Settings ................................W-57

5 Downloading JPEG
Images ................................... W-59

Downloading Images with the WIA
Driver ....................................................W-60

Downloading with [Scanner and Camera
Wizard] ...............................................W-60
Downloading with Windows Explorer . W-62
Downloading with the WIA TWAIN .....W-63

Downloading Images with the TWAIN
Driver ....................................................W-64

6 Working with Images in
ZoomBrowser EX ................. W-65

Starting ZoomBrowser EX ..................W-66
Starting ZoomBrowser EX from an
Event Screen ......................................W-66
Starting ZoomBrowser EX Using the
Icon ..................................................... W-67

Downloading and Saving Images ...... W-69

Printing Images in PhotoRecord .......W-71
Printing Images................................... W-71
Adjusting the Image Quality and
Printing (Exif 2.2 compatible) ..............W-75

Sending E-mail with Attached
Images ..................................................W-76

Processing RAW Images and Merging
Images ..................................................W-78

Processing RAW Images with
ZoomBrowser EX ...............................W-78
Merging Images with PhotoStitch .......W-78

7 Troubleshooting and
Uninstallation........................ W-79

Troubleshooting ..................................W-80

Uninstalling .........................................W-83
Uninstalling (Deleting) the
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This chapter describes how to install the bundled software.

Installing the Software on
Your Computer
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Installing the Software on Windows
● Check that your PC complies with the system requirements for the software (A-8) on the

SOLUTION DISK as you follow the installation procedure.
● For instructions for installing Photoshop Elements, refer to (W-8).

Correct Installation Procedure
● Always install the software as described in the procedures below.

1 Start up your computer.
2 to 11 Install the software.

● Never connect the camera to your computer before you have installed the
software. The software will not be installed correctly.

● Connect the camera to your computer for the first time in step 14.

12 Remove the CD.
13 Check the camera’s communication mode.
14 to 15 Complete the installation.

● Once you connect the camera to your PC, installation is complete.

● If you were unable to successfully install the software using the
procedure given in this guide, see “When You Have Problems with
Installation” (W-7).

● If you connected the camera to your computer before installing the
software, see “Troubleshooting” (W-82).

1 Start up your computer.
● Close any programs that are running.

2 Insert the CD (EOS DIGITAL SOLUTION DISK).
\ The Installer panel appears.

If the Installer Panel Does Not Appear
Click the [Start] button s [My Computer]. (In other versions of Windows,
double-click [My Computer] on the desktop) Then right-click the CD-ROM
drive containing the CD, select [Open] from the menu that appears and
double-click the [SETUP] icon.

3 Click [Software Installation].
\ The [Preparing to Install] window is

displayed, and after a brief wait,
the [Welcome to the InstallShield
Wizard for Solution Disk] window is
displayed.
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Installing the Software on Windows

4 Click the [Next] button.

5 Check the details of the User License Agreement.
● If you have checked the details and agree to the terms of the Agreement, click the

[Yes] button.

6 Check the folder in which the software will be installed.
● Check the details and click the [Next] button.

7 Check the software to be installed.
● Check that the checkboxes for the

software to be installed are
selected and then click the [Next]
button.

To use File Viewer Utility, ZoomBrowser EX or RemoteCapture, you must install one of
the following drivers at the same time, depending on your version of Windows:
• Windows XP, Me: [Canon Camera WIA Driver]
• Windows 2000, 98 SE: [Canon Camera TWAIN Driver]

8 Click the checkbox for [EOS Kiss/REBEL/300D].
● Once you have clicked the [EOS Kiss/REBEL/300D] checkbox so that it changes to

, click the [Next] button.

9 Check the installation details.
● Check the details and click the [Next] button.
\ Installation begins.
● The time required for the installation varies depending on your computer, but should

take approximately 2 to 4 minutes.

10 Click the [OK] button.
● Check the information in [Canon Solution Disk setup...] and then click the [OK]

button.
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Installing the Software on Windows

Dedicated
USB cable

DIGITAL terminal

Dedicated USB cable

USB port

11 Restart your computer.
● Check that  is inserted in [Yes, I want to restart my computer now.] and then

click the [Finish] button.

● When [EOS Kiss REBEL 300D] screen (event screen) and the [Scanner and
Camera Wizard] dialog box appear, click the [Cancel] buttons and close all the
open windows.

● When a window appears prompting you to restart your computer, restart the
computer.

Do not set the camera’s power switch to <OFF> until the [Found New Hardware]
message automatically disappears.

Do not remove the CD before restarting your PC. Remove the CD in step 12.

12 Remove the CD.
\ Once the computer has restarted, remove the CD.
● When the Installer panel appears, click [Exit] to exit the Installer and then remove

the CD.

13 Check the camera’s communication mode.
● Set the camera’s power switch

to <ON> and check that
[Communication] in menu
<  > is set to [Normal].

● When you have finished the
settings, set the camera’s power
switch to <OFF>.

14 Connect the camera to your computer.

15 Set the camera’s power switch to <ON> to complete the
installation.
\ When you set the camera’s power switch to <ON>, the [Found New

Hardware] message appears. When the message automatically disappears,
installation is complete.
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Installing the Software on Windows

For Windows 2000, Me and 98 SE users :
● When you set the camera’s power

switch to <ON>, a dialog box such as
[Found New Hardware] or [Create
driver information database] appears,
depending on your operating system
and computer system. If the display
automatically clears at this point,
installation is complete.

Do not set the camera’s power switch to <OFF> until the [Found New Hardware] or
[Create driver information database] message automatically disappears.

● When [EOS Kiss REBEL 300D] screen (event screen) and the [Scanner and Camera
Wizard] dialog box appear, click the [Cancel] buttons and close all the open windows.

● When a window appears prompting you to restart your computer, restart the computer.

When You Have Problems with Installation
If you have problems with installation, check the items listed below. If the [Add New Hardware
Wizard] ([Found New Hardware Wizard] in Windows 2000) dialog box appears while you are
checking these items, click the [Cancel] button and disconnect the camera from your
computer. Then re-install.

(1) Does your computer comply with these requirements?
● PC with Windows XP, Windows 2000, Windows Me or Windows 98 SE preinstalled and

a USB port as a standard feature. (A-8)

(2) Is the camera connected correctly?
● See steps 13 and 14 for the connection method.

(3) Are the camera and computer set up correctly for communication?
● Is the camera’s power switch set to <ON>?
● Check that the camera’s communication mode is set to [Normal]. See step 12 for

information on setting the communication mode.
● Even when the camera’s power switch is set to <ON>, operation of the Auto power off

function will automatically switch the camera off. To prevent this, set the Auto power off
function to [Off]. (Refer to “Menu Settings” in the Instructions provided with your
camera.)

(4) Is there sufficient charge left in the camera battery?
● When the camera is connected to a computer, you should use the DC Coupler Kit

(optional) so that you can continue using the camera regardless of battery level.

If there are none of the problems listed above and you still cannot install successfully, see
“Troubleshooting” (W-80) or “Uninstalling” (W-83) and then repeat the installation procedure
from the beginning.
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● You are required to enter the serial number when installing Photoshop Elements 2.0. The
serial number is on a sticker attached to the Photoshop Elements 2.0 CD-ROM case.

● If you lose the serial number, you will not be able to install the software. To ensure that you
do not lose the serial number, carefully copy the serial number from the CD-ROM case or
transfer the serial number sticker into the field below.

1 Load the Adobe Photoshop Elements 2.0 CD-ROM into the CD-
ROM drive.
\ The installation screen automatically appears.
● If the installation screen does not appear, click the [Start] button s [My Computer].

(In other versions of Windows, double-click [My Computer] on the desktop.) Then
right-click the icon for the CD-ROM drive containing the Adobe Photoshop Elements
2.0 CD-ROM, select [Open] from the menu that appears and double-click the
[AutoPlay] icon.

2 Click the [Next] button.

3 Read the entire User License Agreement carefully. If you agree to
the terms of the license, click the [Accept] button.

4 Check that the [Installation] button is selected and click the
[Adobe® Photoshop® Elements 2.0] button.

5 Proceed with the installation as directed by the on-screen
messages.

For detailed information on installing Photoshop Elements 2.0, refer to the
[How_to_Install Read Me] file on the Photoshop Elements 2.0 CD-ROM. To open the
[How_to_Install Read Me] file, click the [Start] button s [My Computer]. (In other
versions of Windows, double-click [My Computer] on the desktop.) Then right-click the
icon for the CD-ROM drive containing the Adobe Photoshop Elements 2.0 CD-ROM
and select [Open] from the menu that appears.

Please Register Your Camera!
We recommend you take a moment to register your camera, in order to receive further product
information.
To proceed to the online User Registration page, simply click the [User Registration] button
from the [EOS DIGITAL SOLUTION DISK].
If there is no response when you click the [User Registration] button, please double-click on
the [/SOFTWARE/INSTDATA/ENGLISH/REGIST.HTML] file from Windows Explorer.

Installing Photoshop Elements 2.0
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This chapter explains how to set the communication mode, how to connect
the camera to your computer, and how to use a card reader (third-party
product).

Getting Ready to Work with
Images
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To communicate with the camera using the software on the SOLUTION DISK, set the
camera’s communication mode to [Normal].

If you set the communication mode to [PTP], the SOLUTION DISK software
cannot communicate with the camera. When you are using the software, always
set the communication mode to [Normal].

1 Check that the camera is not connected to the computer and then
set the power switch to <ON>.

2 Set [Communication] in menu option <  > to [Normal].

Setting the Communication Mode

3 Press the <MENU> button to switch the LCD monitor display off
and then set the power switch to <OFF>.

When setting the communication mode, always ensure that the camera is not
connected to the computer beforehand. Setting the communication mode while the
camera is connected to the computer will cause camera and software malfunctions.

About the PTP Setting
The PTP function is only available to Windows XP users. This function provides a simple
means of downloading JPEG images to your computer. To use this function, set
[Communication] to [PTP] in step 2 above.
● For more information on using the PTP function to download JPEG images, see

“Downloading JPEG Images Using the PTP Function in Windows XP” (W-14).
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Dedicated
USB cable

DIGITAL terminal

USB port

Dedicated
USB cable

Connect the camera to your computer with the dedicated USB cable so that they can
communicate. You can connect the camera while your computer is running.

● When you connect the camera to your computer, be sure to follow the
procedure below.

● Never perform the following operations while the software installed from the
SOLUTION DISK is running after connecting the camera to the computer as a
communications error may occur.
• Set the camera’s power switch to <OFF>.
• Open the CF card slot cover.
• Disconnect the dedicated USB cable or remove the battery.
• Disconnect the DC coupler (optional) or unplug the AC adapter (optional) or

power cord.
Before you perform the operations above, be sure to exit the software being
used.

1 Plug the dedicated USB cable into the computer.
● Plug the cable into the USB port on

the computer.
● The location of the port differs

depending on your computer. Refer
to the User’s Manual for your
computer for details.

Connecting the Camera to Your Computer

2 Plug the dedicated USB cable into your camera.
● Open the cover and plug the cable

connector into the <  >
terminal with the <  > (USB)
icon facing the front of the camera.

3 Set the camera’s power switch to <ON>.
\ The [EOS Kiss REBEL 300D] screen (event screen) and the [Scanner and Camera

Wizard] dialog box appear.
● ZoomBrowser EX users should refer directly to “Chapter 6 Working with Images in

ZoomBrowser EX”.
● If you are not using ZoomBrowser EX, click the [Cancel] button, close all the open

windows and refer to the Chapter that deals with your software.
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Connecting the Camera to Your Computer

● Use only the dedicated USB cable to connect the camera to your computer.
● Push the plug firmly all the way into the socket. Loose connections can cause

faults or malfunctions.
● Connect the camera to the computer directly using the dedicated USB cable. The

camera and computer may not operate correctly if you connect them via a hub or if
you connect to multiple USB devices.

● The connection may not operate correctly if you are using other USB devices,
excluding USB mouse or keyboards, at the same time. If this occurs, disconnect
the other USB devices from the computer and try reconnecting the camera.

● Do not connect more than one camera to the same computer. The connections
may not operate correctly.

● While the camera and your computer are communicating, the camera’s LCD
panel may blink and, if you are using the LCD monitor, the image on the monitor
may flicker. This is not a malfunction.

● When unplugging the dedicated USB cable, be sure to grip the sides of the plug as
you pull it out.

● If you do not perform any operation while the camera and computer are connected,
a confirmation message appears on the computer screen asking whether you wish
to continue communicating with the camera for some computer systems. If you do
not perform any operation even after this message appears, the communication
with the camera is terminated. To re-establish the communication, press the
shutter button down halfway or set the camera’s power switch to <OFF> and then
back to <ON>.

● Do not put your computer to sleep while it is connected to the camera.
If you do put your computer to sleep while it is connected to the camera, never
disconnect the dedicated USB cable while your computer is still in sleep mode.
Always wake your computer up before disconnecting the camera. On some types
of computer, disconnecting the dedicated USB cable while your computer is in
sleep mode could prevent the computer from waking up correctly. Refer to the
computer User’s Manual for more information on Sleep mode.

When the camera is connected to a computer, you should use the DC Coupler Kit
(optional) so that you can continue using the camera regardless of battery level.

About Backing up (Copying) Images
You should back up (copy) the captured images on the hard disk of your
computer, etc. before working with EOS DIGITAL SOLUTION DISK.
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IMG_xxxx.JPG (JPEG images)

The folder that holds the image control files in the DCIM folder.

The folder created when DPOF settings are set. 
It holds the DPOF settings files.

CRW_xxxx.CRW (RAW images)

CRW_xxxx.THM (image used to show the camera index)

Users with a third-party card reader can download images directly from a CF card to the
computer.

1 Remove the CF card from the camera.

2 Load the card into the card reader.

Inserting a CF Card into Your Card Reader

3 Start your software and download the images.

For information on connecting the card reader to your computer, refer to the User’s
Manual provided with the card reader.

CF Card Folder Structure and File Names
The images on a CF card are placed in sub-folders named [xxxCANON], where the “xxx”
represents a number between 100 and 999, within the [DCIM] folder.

● The “xxxx” in file names represents four-digit numbers.
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Windows XP users can use the PTP (Picture Transfer Protocol) function. The PTP function
allows you to download JPEG images stored on a CF card in the camera to your computer
without having to start the software provided on the SOLUTION DISK.

1 Set the camera’s communication mode to [PTP] (W-10).
● Set [Communication] in menu

option <  > to [PTP].
● Press the <MENU> button to clear

the LCD monitor display.
● When you have finished, switch the

camera off.

Downloading JPEG Images Using the PTP Function in Windows XP

2 Connect the camera to the computer and set the camera’s power
switch to <ON> (W-11).
\ The [Scanner and Camera Wizard]

dialog box appears.

3 Download images as directed in the [Scanner and Camera
Wizard] dialog box.
● For the procedure for downloading JPEG images using the [Scanner and Camera

Wizard], refer to step 2 onwards in “Downloading with [Scanner and Camera Wizard]”
(W-60).
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This chapter explains how to use File Viewer Utility to display and save
images stored on a CF card loaded in the camera, and also explains how
to perform image processing including processing RAW images and how
to transfer images to the retouching software.
● For more information on using File Viewer Utility, refer also to the sources listed

below.
Readme: Click the [Start] button and select [All Programs] ([Programs] in other

versions of Windows) s [Canon Utilities] s [FileViewerUtility xx] (“xx”
is the version) s [FileViewerUtility Readme].

Help: Displayed by clicking the [Help] button in the File Viewer Utility main
window.

Working with Images in
File Viewer Utility



W-16

1 Connect the camera to your computer. (W-11)
\ The [EOS Kiss REBEL 300D] screen (event screen) and the [Scanner and Camera

Wizard] dialog box appear.
● Click the [Cancel] button and close all the open windows.

2 Click the [Start] button and select [All Programs] ([Programs] in
other versions of Windows) s [Canon Utilities] s
[FileViewerUtility xx] s [FileViewerUtility].
● You can also start File Viewer Utility by double-clicking the [FileViewerUtility] icon on

the desktop.
● File Viewer Utility version information is displayed in xx.
\ The File Viewer Utility main window appears.

Starting File Viewer Utility



W-17

W
or

ki
ng

 w
ith

 Im
ag

es
 in

 F
ile

 V
ie

w
er

 U
til

ity

W

3

Starting File Viewer Utility

Display Mode list box (W-23)

Menu bar
Displays the [File], [Edit], [View],
and [Help] menus. Model-specific processing mode list box (W-22)

Path display
Displays the connected camera,
drive on your computer and folder.

Histogram
Shows the distribution of
the brightness of an image.

Display Size list box (W-24)
Image transfer mode
list box (W-43)

Image display area

Status bar Comment input box
(W-28) Image information display area

(W-28)

Tree View Area (W-20)
RGB value display
When you move the cursor over an image, the
coordinates of the cursor position and its RGB
values (8-bit conversion) are shown here.

Show/Hide Thumbnail Frames button (W-25)

File Viewer Utility main window

* The above window shows all the information at once. In actual use, only the
information needed is displayed.

● To exit File Viewer Utility, select [Exit] from the [File] menu on the menu bar.
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Starting File Viewer Utility

Display AF point button (W-24)

Save File button (W-36, W-38, W-40)

Erase Image button (W-27)Preferences button
(W-44)

Camera Settings button
(W-46)

Refresh button (W-25)

IPTC information button
* This button is not supported for

images shot on your camera.

Select Image button (W-26)

Transfer Images button (W-43)

Select final image button (W-21)

Enter Image Number input box (W-21) Remove protect button (W-26)

Select first Image button (W-21) Show Help button

Select Previous Image button
(W-21)

Version button

Select Next Image button
(W-21)

Play sound button
* This button is not supported for

images shot on your camera.

Protect button (W-26)

* The above window shows all the information at once. In actual use, only the
information needed is displayed.

Rotate left 90 degrees button (W-27)

Rotate right 90 degrees button (W-27)
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Starting File Viewer Utility

Digital Exposure Compensation button (W-30)

White Balance list box
(W-31, W-32)

Color Temp. input box
(W-32)

Click White Balance button
(W-33)

Contrast list box (W-34)

Color tone list box (W-34)

Color saturation list box
(W-34)

Sharpness list box (W-35)

Color Space list box (W-35)

* The above window shows all the information at once. In actual use, only the
information needed is displayed.
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You can display images stored on a CF card in a camera or your computer.
RAW images are processed and displayed according to the processing parameters set on the
camera.
You can display images stored on a CF card via the dedicated USB cable while the CF card is
still in the camera. Or you can display images stored on a CF card using a third-party card
reader.
This section describes how to display images stored on a CF card in the camera.

Select a folder that contains images to be displayed.
● Double-click [EOS DIGITAL

REBEL] and then click the plus
symbol [ + ] to the left of the [DCIM]
folder s the [100CANON] folder in
[Tree View Area].

\ The images saved in the selected
folder are displayed.

Displaying Images

A number between 100 and 999 is displayed.

● The following images can be displayed in File Viewer Utility.
• JPEG images shot on a Canon digital camera
• RAW images shot on a Canon digital camera
• TIFF and JPEG images saved in File Viewer Utility (W-36)
* Images that cannot be displayed by File Viewer Utility appear as a question mark

[?].
● When you are displaying images stored on a computer or images on a CF card

using a third-party card reader, you can display the images in a folder by clicking
that folder in the same way.

● Images for which [Auto rotate display orientation] is set that were shot with the
camera held vertically are automatically displayed vertically.

● If the selected folder contains a large number of images, there may be a short delay
before the images appear.

● You can copy or move a folder in [Tree View Area] by dragging and dropping it onto
another folder. On the menu that is displayed by right-clicking on the folder, you can
create and delete the folder, or change the folder name.

● Images that have been processed on your computer after being shot or images
whose file name has been changed may not be displayed properly.

● Deleting a folder erases all the images in that folder. Erased images cannot be
restored. Check carefully before deleting folder.

Your camera model is displayed.
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Selecting Images with the Mouse

Position the mouse cursor over the image and click on it.
● To select multiple images, hold

down the <Ctrl> key and click the
images.

● To select consecutive images, click
the first image and then hold down
the <Shift> key and click the last
image.

\ The frame around the selected
image changes color.

To select an image using the keyboard, use the arrow keys (↑ ← → ↓) to select an
image.

Selecting Images from the Control Panel

Use the button or input a value.

[Select final image] button
Selects the last thumbnail image
displayed.

[Select first Image] button
Selects the first thumbnail
image displayed.

[Select Previous Image] button
Selects the image before the
currently selected image.

[Enter Image Number] input box
Selects the image with the specified
number. You can enter a number
between 1 and 9999.
Enter the number and press the
<Enter> key.

[Select Next Image] button
Selects the next image.

Selecting Images
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Selecting the Model-Specific Processing Mode
You can display the RAW image process tool bar to check and modify the processing used for
RAW images.
By selecting the model of the camera on which images were shot (model-specific processing
mode) in the [Model-specific processing mode] list box, you can check and/or modify the
processing used for RAW images shot on the selected camera.

Select a model-specific processing mode from the [Model-
specific processing mode] list box.

[Common Processing]
The RAW image process tool bar is hidden and the settings for RAW image processing
cannot be changed.

[EOS DIGITAL REBEL] / [EOS 300D DIGITAL]
The RAW image process tool bar is displayed. By selecting RAW images, you can check
and/or modify the image processing used. When a JPEG image is selected, however, the
RAW image process tool bar is grayed out and disabled.

When images shot on Canon cameras other than your camera are saved in the
selected folder or on a CF card in the connected camera, the model-specific
processing mode for the camera on which the images were shot is automatically
added to the [Model-specific processing mode] list box.

● See “Modifying RAW Image Processing Parameters” (W-29) for information on how
to change the RAW image processing parameters.

● If you select any other camera from [Model-specific processing mode] list box, the
RAW image process tool bar for the selected camera is displayed.

EOS DIGITAL REBEL /
EOS 300D DIGITAL
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■ [Preview]
RAW images are displayed as single RAW images and JPEG images are displayed as single
JPEG images.

■ [JPEG Preview]
When you select a RAW image, simultaneously recorded JPEG image (Middle/Fine) in the
RAW image is displayed as a single image.
When you select a JPEG image, it is displayed as a single image just like the [Preview] mode.

● When you start File Viewer Utility, images are always shown in the [Thumbnail
display] mode.

● If you double-click on the thumbnail-displayed image, it is displayed in the [Preview]
mode.

● When you use your camera to shoot a RAW image, a JPEG image (Middle/Fine) is
recorded at the same time. When you select [JPEG Preview] for a RAW image, the
JPEG image (Middle/Fine) included in the RAW image is displayed.

Selecting the Image Display Mode

Display number
Numbers are assigned
sequentially to the
displayed images starting
with the first image. Recording format

The [RAW] symbol is displayed
for RAW images. No symbol is
shown for JPEG images.

Digital exposure
compensation value (W-30)

File name or shooting date/time
The items selected in the [Image Lower Display Item]
list box in the [General Settings] tab sheet of the
[Preferences] dialog box (W-44) are displayed.

Protect mark (W-26)
This mark is displayed for
protected images.

You can select the mode and size used when images are displayed. You can also display the
AF point and choose whether the information display frame for thumbnail images is displayed.

Selecting the Display Mode

Click the [Display Mode] list box and select the mode.
\ The images are displayed in the

selected display mode.

■ [Thumbnail display]
This shows multiple images arranged in sequence. The information shown below is also
displayed for the images.
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Selecting the Image Display Mode

Selecting the Display Size

Click the [Display Size] list box and select the display size.
\ The image is displayed in the

selected display size.

In the [Preview] mode, the available image sizes are [Large] (100% – pixel-
equivalent), [Middle] (50%) and [Small] (25%).

Checking the AF Point
The AF point used when the shot was taken can be displayed.

1 Select [Preview] or [JPEG Preview] from the [Display Mode] list
box. (W-23)

2 Click the [Display AF point] button.
\ The AF point used when the shot

was taken is displayed.
● Click the button again to hide the

AF point.

For images taken with One-Shot AF, the active AF point is displayed. When the shot
was taken with automatic AF point selection, multiple active AF points might be
displayed.
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Selecting the Image Display Mode

Showing/Hiding the Information Display
Frame of Thumbnail Images

You can hide the information displayed on the frame of the thumbnail images (W-23) to display
more images in the image display area.

1 Select [Thumbnail display] from the [Display Mode] list box.
(W-23)

2 Click the [Show/Hide Thumbnail Frames] button.

\ The information display frame of the thumbnail image is hidden.
● Click the button again to display the information display frame of the thumbnail image.

Updating Information on Main Window
If you alter the content of the folders currently displayed in [Tree View Area] (by copying or
deleting images) while the images in a folder are displayed in the main window, the
information shown in the main window may no longer match the actual folder content. If this
occurs, update the main window display so that it matches the new folder information.

Click the [Refresh] button.
\ The information displayed in the

main window is updated.

Showing/Hiding Image Information
You can hide the histogram and image information display area to display more images in the
image display area.

Select the [View] menu s [Information Area] s [Hide].
\ The histogram and image information display area are hidden.
● If you select the [View] menu s [Information Area] s [Show], the histogram and

image information display area are displayed.
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Protecting Images
You can protect important images to prevent them from being accidentally erased.

Click the [Protect] button.

● When multiple images are selected, all the selected images are protected.
● The [  ] is automatically displayed for images that were protected on the camera.
● Protection only prevents images from being erased. Other types of image

processing can still be performed for protected images.
● A range of operations is also available by selecting the image, pressing the right

mouse button and selecting an option from the menu that appears.

\ The image is protected and the [  ] icon appears in the information display frame
for the image.

● Clicking the [Remove protect]
button unprotects the image and
clears the [  ] icon from the
information display frame for the
image.

Selecting Images by Condition
This feature allows you to select multiple images in a single operation using conditions.

Click the [Select Image] button and select the condition from the
menu that appears.
\ Only images that meet the

condition are selected.

Working with Selected Images
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Working with Selected Images

Rotating Images
Use the procedure below to rotate a selected image by 90-degree increments left or right.

Rotate the image.
● To rotate the image right

(clockwise), click the [Rotate right
90 degrees] button.

● To rotate the image left
(counterclockwise), click the
[Rotate left 90 degrees] button.

\ The image rotates 90 degrees in
the selected direction.

● When multiple images are selected, all the selected images are rotated.
● Images for which [Auto rotate display orientation] is set that were shot with the

camera held vertically are automatically displayed vertically.
● If a rotated image is displayed in another application, the image may not appear

rotated.
● A range of operations is also available by selecting the image, pressing the right

mouse button and selecting an option from the menu that appears.

Erasing Images
Use the procedure below to erase unwanted images from a CF card or your computer.

1 Click the [Erase Image] button.
\ An erase confirmation dialog box

appears.

2 Click the [OK] button.
\ The image is erased.

● Erased images cannot be restored. Check carefully before erasing images.
● Protect important images (W-26) to prevent them from being accidentally erased.
● When multiple images are selected, all the selected images are to be erased. Take

particular care when you have just finished a task involving the selection of multiple
images.

A range of operations is also available by selecting the image, pressing the right
mouse button and selecting an option from the menu that appears.



W-28

Working with Selected Images

Checking the Image Information and
Entering Comments

Shooting information is recorded when images are taken. You can check the shooting
information by selecting the image. Also, you can copy shooting information to paste it into
another application, and you can add a comment.

When the shot was taken using Adobe RGB
To transfer images shot in Adobe RGB color to retouching software for displaying, use
retouching software that supports Adobe RGB and specify [AdobeRGB] as the RGB
setting for display.

Printing Images
You can use File Viewer Utility to print images in index format.

1 Select images to be printed in index format (W-21).

2 Select [Print Index] in the [File] menu.
\ Printing begins.

Image information display area
● Displays information such as the file name, camera model name and shooting

data. The number of items displayed differs depending on the camera settings.
● When you select multiple images, the information from the image selected last is

displayed.
● You can copy the information as text data and paste it into another application.

Comment input box
You can use this box to type in a comment up to 120 characters long.
Type in your comment and press the <Enter> key.

If you wish to specify the printer settings, select [Page Setup] from the [File] menu.
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Processing RAW Images
RAW images are processed based on the settings specified on the camera (including the
processing parameters and white balance) and then displayed on the computer.

● RAW images are processed in the following situations:
• When the display mode is switched from [Thumbnail display] to [Preview]
• When the processing parameters are changed while the image is displayed in [Preview] or

[Thumbnail display] mode
• When the image is converted to the TIFF or JPEG format and saved
• When the image is converted to the TIFF format and transferred to the designated

retouching software
* Linear processing and false color suppression can only be specified when an image is saved or is

transferred to retouching software (W-45).

● Approximate processing times

• The processing times given here are only approximations. Actual processing times
vary widely depending on the images and the computer system.

• Processing times are based on Canon testing standards.
(OS: Windows XP; CPU: 2.2 GHz Pentium 4; RAM: 256 MB)

• The processing time in the retouching software includes starting up time of the retouching
software.

Modifying RAW Image Processing
Parameters

File Viewer Utility allows you to modify the image processing parameters until the displayed
RAW image is optimal for its intended purpose. You can also specify additional processing
parameters not available on the camera, such as digital exposure compensation and white
balance adjustment using the Click White Balance function.

● This processing applies the specified parameters virtually and does not affect the original
RAW images in any way. Consequently, you can redo the processing as often as you like
with different parameters and then reset the modified parameters to the settings used when
the shot was taken.

When the display mode is
switched from [Thumbnail display]
to [Preview]

Image converted to TIFF format
and transferred to the specified
retouching software

When the display mode is
switched from [Thumbnail display]
to [Preview]

Image converted to TIFF format
and transferred to the specified
retouching software

Processing TimeProcessing Parameters

When RAW images saved on
a CF card in the camera are
processed

When RAW images saved on
the computer’s hard disk are
processed

Approx. 35 sec.

Approx. 49 sec.

Approx. 8 sec.

Approx. 22 sec.
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Processing RAW Images

Compensating the Brightness (Digital Exposure Compensation)
You can compensate the brightness of an image in the range of +/–2 stops in 0.1-stop
increments.

1 Click the [Digital Exposure Compensation] button.
\ The [Digital Exposure

Compensation] dialog box appears.

2 Compensate the image brightness.
● Position the mouse cursor over the

slider and drag it left or right to
adjust the amount of
compensation.

● When you click the [Preview]
button, the image brightness
changes to reflect the value to
which the slider was dragged.

3 Click the [OK] button.
\ The corrected value is applied to the image and the [Digital Exposure Compensation]

dialog box closes.
\ The corrected value is displayed with the corrected image.

1 Select [EOS DIGITAL REBEL] from the [Model-specific
processing mode] list box. (W-22)

2 Select the RAW image to be processed. (W-21)
● See the following information on how to modify the processing parameters.

3 Save (W-36) and transfer (W-42) the image.
● You can specify the bit depth used when the image is saved and transferred in the

[RAW Image Processing settings] tab sheet in the [Preferences] dialog box (W-45).

Processing parameters modified in File Viewer Utility are all cancelled and the
parameters used when the shot was taken are restored when you exit File Viewer
Utility. Consequently, you should convert images with modified parameters to the TIFF
or JPEG format and save them, or transfer them to the retouching software and save
them.

If you selected multiple images, the specified processing parameters are applied to all
the selected RAW images.
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Processing RAW Images

Adjusting the White Balance
You can adjust the white balance in your RAW images.
You can adjust the white balance by selecting a setting in the [White Balance] list box. You can
also make fine adjustments to the white balance by using the Click white balance function,
which allows you to adjust the white balance by selecting a white area in the image.

Select the White Balance

Select the desired setting from the [White Balance] list box.
● The table below shows the 9

available white balance settings.
\ The selected setting is applied to

the image.

White Balance

Shot Settings

Auto

Daylight

Shade

Cloudy

Tungsten

Fluorescent

Flash

Color Temp

Details

To apply the white balance setting used when the
shot was taken.

File Viewer Utility automatically sets the white
balance.

For sunny daylight outdoors.

For shaded areas outdoors.

For cloudy or hazy days and during sunset.

For tungsten (light bulb) light.

For fluorescent light.

When flash is used.

You can manually set color temperature for 2800
to 10000K (in 100K increments). (W-32)

Color temp./K (Kelvin)

–

Approx. 3000 to 7000

Approx. 5200

Approx. 7000

Approx. 6000

Approx. 3200

Approx. 4000

Approx. 6000

Approx. 2800 to 10000
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Processing RAW Images

Setting the Color Temperature
You can set the color temperature to a value between 2800K and 10000K (in 100K
increments).

1 Select [Color Temp] from the [White Balance] list box.

2 Enter a color temperature.
● Enter the color temperature in the

[Color Temp.] input box.
● You can enter values between

2800K and 10000K (in 100K
increments).

3 Press the <Enter> key.
\ The specified value is applied to the image.
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Processing RAW Images

Click White Balance Function
This function allows you to automatically adjust the white balance simply by clicking a point in
a white part of the image.

1 Click the [Click White Balance] button.
\ When you move the cursor over

the image, it changes to the shape
of an eyedropper.

2 Click in a white area in the image.

\ The white balance is adjusted so that the area clicked appears white and the result is
displayed.

● To adjust the white balance using a different location, click the [Click White Balance]
button again.

When you use Click White Balance Function, [White Point] is displayed in the [White
Balance] list box.
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Processing RAW Images

Adjusting the Color in Images
Use the procedures below to adjust the color parameters (contrast, color saturation and color
tone) in images. You can adjust the color by selecting settings from the respective list boxes.

Adjusting the Contrast

Select the desired setting from the [Contrast] list box.
\ The selected setting is applied to

the image.

Adjusting the Color Saturation

Select the desired setting from the [Color saturation] list box.
\ The selected setting is applied to

the image.

Adjusting the Color Tone

Select the desired setting from the [Color tone] list box.
\ The selected setting is applied to

the image.
● [–2] strongly adjusts the colors so

that skin tones appear redder while
[–1] makes the same adjustment
less strongly.
[0] applies the standard color
matching adjustment.
[+2] strongly adjusts the colors so
that skin tones appear yellower
while [+1] makes the same
adjustment less strongly.
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Processing RAW Images

Adjusting the Sharpness
You can adjust the edge sharpness of the image.

Select the desired level from the [Sharpness] list box.
\ The selected level is applied to the

image.

Specifying the Color Space
Use the procedure below to change the color space for the image.

Select the desired setting from the [Color Space] list box.
\ The selected setting is applied to

the image.

Copying the Processing Parameters for RAW Images
This process allows you to quickly and easily apply the processing parameters used for one
RAW image (such as the digital exposure compensation and white balance adjustment
settings) to other images.

1 Right-click a RAW image that has been processed and select
[Copy Current Conditions] from the menu that appears.

2 Right-click the RAW image to which you want to apply the
parameters and select [Paste Current Conditions] from the menu
that appears.
\ The copied processing parameters are applied to the selected RAW image.
● You can apply the same processing parameters to multiple RAW images by copying

the processing parameters, selecting the RAW images (W-21), right-clicking one of
the selected images and then selecting [Paste Current Conditions] from the menu
that appears.

When transferring images that were set to [AdobeRGB] to retouching software, use
retouching software that supports Adobe RGB and specify [AdobeRGB] as the RGB
setting for display.

When you exit File Viewer Utility, all the modified processing parameters are cancelled
and the parameters used when the shot was taken are restored. (W-29)
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3 Specify the desired settings and click the [OK] button.
\ The images are saved in the selected folder.

11
12

6

Saving Images
This section explains how to save captured images stored on a CF card onto your computer,
how to extract JPEG images from RAW images using a simple procedure and then save the
JPEG images onto your computer, and how to save multiple images as an index file on your
computer.

Saving Images from the Camera to Your Computer
You should save the images you have shot on your computer.

1 Select images to be saved. (W-21)

2 Click the [Save File] button and select [Convert and save in file]
from the menu that appears.
\ The [Save File] dialog box appears.

5
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Saving Images

1 The converted image is saved as a new image in the same folder as the selected image.
You cannot use this option when the images selected are saved on a CF card in the
camera. This option is only available when the selected images are saved on your
computer or on a CF card in a card reader.

2 Use this button when you want to specify the folder in which the image will be saved.
3 When the [Save in following specified folder] radio button is selected, this button specifies

the folder in which the image will be saved.
4 Shows the folder in which the image will be saved.
5 Select this option when the images to be saved include RAW images.

Select [Do not convert], [Exif-JPEG], [Exif-TIFF(8bit/ch)] or [TIFF(16bit/ch)].
The file extensions used for the saved files are shown below.

Conversion Format

Do not convert

Exif-JPEG

Exif-TIFF(8bit/ch)

TIFF(16bit/ch)

File Extension

_.CRW

_RJ.JPG

_RT8.TIF

_RT16.TIF

To use linear processing, specify linear processing in the [Preferences] dialog box (W-
45) and select [TIFF(16bit/ch)] when you save the image. Even when linear
processing is specified, linear processing cannot be applied to images saved in [Exif-
TIFF(8bit/ch)] format.

6 You can specify the [Compression Ratio] (image quality) when you select [Exif-JPEG] from
the [Convert from RAW to Other Format] list box. You can select from 4 compression
ratios-[4 (Highest Image Quality)] to [1 (High Compression Ratio)]. The higher the value,
the higher the quality of the JPEG image.

7 Click this checkbox when you want to save the image without changing the name.
8 This is text inserted before the file number for sorting. You can enter up to 12 characters.

When you enter text, an example of the file name appears in the [Example] field below the
text box.

9 You can specify up to 9 digits for the file number.
10 Specifies the first file number.
11 Images shot on your camera do not support this function.
12 Images shot on your camera do not support this function.

A range of operations is also available by selecting the image, pressing the right
mouse button and selecting an option from the menu that appears.
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Extracting JPEG Images from RAW Images
When a RAW image is shot on your camera, a JPEG image (Middle/Fine) is recorded at the
same time. You can save the JPEG image (Middle/Fine) included with the RAW image to your
computer by selecting the RAW image shot on your camera and extracting the JPEG image.

1 Select the RAW image from which a JPEG image is to be
extracted. (W-21)

2 Click the [Save File] button and select [Extract Save JPEG] from
the menu that appears.
\ The [Extract & save JPEGs] dialog

box appears.

3 Specify the desired settings and click the [OK] button.
\ The JPEG image is saved in the selected folder.

7
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Saving Images

1 The converted image is saved as a new image in the same folder as the selected image.
You cannot use this option when the images selected are saved on a CF card in the
camera. This option is only available when the selected images are saved on your
computer or on a CF card in a card reader.

2 Use this button when you want to specify the folder in which the image will be saved.

3 When the [Save in following specified folder] radio button is selected, this button specifies
the folder in which the image will be saved.

4 Shows the folder in which the image will be saved.

5 Click this checkbox when you want to save the RAW image without changing the name.

6 This is text inserted before the file number for sorting. You can enter up to 12 characters.
When you enter text, an example of the file name appears in the [Example] field below the
text box.

7 You can specify up to 9 digits for the file number.

8 Specifies the first file number.

A range of operations is also available by selecting the image, pressing the right
mouse button and selecting an option from the menu that appears.
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Saving Images

Saving Images as an Index File
This function combines multiple images into an index image and saves the index on your
computer as a single JPEG file.

1 Select images to be saved as an index. (W-21)

2 Click the [Save File] button and select [Save Index] from the
menu that appears.
\ The [Index Sheet Options] dialog

box appears.

3 Enter the settings and click the [OK] button.
\ The [Save index file] dialog box appears.

1 Enter the width of the index sheet to be created. You can specify values between 4 and
11 inch.

2 Enter the height of the index sheet to be created. You can specify values between 4 and
11 inch.

3 Enter the resolution of the index images. You can specify values between 50 and 300
pixels per inch.

4 Indicates the projected image file size based on the specified width, height and resolution.
5 The settings are applied and the [Index Sheet Options] dialog box closes.
6 Cancels the index sheet options settings.

1

2

3

4

5 6
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Saving Images

4 Specify the desired settings and click the [OK] button.
\ The images are saved as an index in the selected folder.

1 The converted image is saved as a new image in the same folder as the selected image.
You cannot use this option when the images selected are saved on a CF card in the
camera. This option is only available when the selected images are saved on your
computer or on a CF card in a card reader.

2 Use this button when you want to specify the folder in which the image will be saved.
3 When the [Save in following specified folder] radio button is selected, this button specifies

the folder in which the image will be saved.
4 Shows the folder in which the image will be saved.
5 This is text inserted before the file number for sorting. You can enter up to 12 characters.

When you enter text, an example of the file name appears in the [Example] field below the
text box.

6 You can specify up to 9 digits for the file number.
7 Specifies the first file number.

1
2

3 4

5

6

7



W-42

5 Select the folder to be used for saving the transferred images and
then click the [OK] button.
\ The folder is specified and then the [General Settings] tab sheet appears.

6 Click the [OK] button.
\ The settings are applied and the [Preferences] dialog box closes to end the

procedure.

It is not necessary to specify the retouching software to which the images will be
transferred and the folder for saving the transferred image every time unless you wish
to change those settings.

Transferring Images to Retouching Software
This section describes how to transfer images displayed in File Viewer Utility to the retouching
software and also describes how to make settings for image transfer.

● In order to transfer images, you will need the retouching software such as
Adobe Photoshop Elements 2.0.

● Be sure to make the image transfer settings before transferring images.

Specifying the Image Transfer Settings
Before transferring images, it is necessary to specify the retouching software to which images
will be transferred and the folder for saving the transferred images. The descriptions given
here show how to transfer images to Photoshop Elements 2.0, as an example.

1 Display the [General Settings] tab sheet in the [Preferences]
dialog box. (W-44)

2 Click the [Browse] button of [Image Transfer Application].
\ The dialog box for selecting the

retouching software appears.

3 Select [  PhotoshopElements] and then click the [Open]
button.
● Select [C:] drive s [Program Files] s [Adobe] s [Photoshop Elements 2].
\ Photoshop Elements 2.0 is specified as the retouching software to which images will

be transferred and then the [General Settings] tab sheet appears.

4 Click the [Browse] button of [Image transfer folder].
\ The dialog box for selecting the

folder to which images are
transferred (saved) appears.
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Transferring Images to Retouching Software

Transferring Images
This section describes how to transfer the images displayed in File Viewer Utility to the
retouching software. Although the descriptions given here show how to transfer images to
Photoshop Elements 2.0, as an example, you can also transfer images by following the same
procedure even if you specify any other retouching software in “Specifying the Image Transfer
Settings”.

1 Select images to be transferred. (W-21)

2 Select the transfer mode from the [Image transfer mode] list box.
● There are 2 available transfer

modes.
[Single-Frame Transfer]:
The selected images are
transferred as an individual image.
[Transfer as Index Image]:
Thumbnails are created for the
selected images and transferred as
an index sheet (JPEG format).

3 Click the [Transfer Images] button.
\ If you selected [Transfer as Index

Image], the [Index Sheet Options]
dialog box appears.

\ If you selected [Single-Frame
Transfer], the image will be
transferred.

● For information on how to make
settings in the [Index Sheet
Options] dialog box, refer to step 3
in “Saving Images as an Index File”
(W-40).

4 Enter the settings and click the [OK] button.
\ Photoshop Elements 2.0 starts up and displays the transferred image.
\ The transferred image is saved in the image transfer folder that you have set.
\ RAW images are processed and then converted to TIFF format before being

transferred.

A range of operations is also available by selecting the image, pressing the right
mouse button and selecting an option from the menu that appears.
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● You can specify the settings shown below in the [General Settings] tab sheet.

1 When you click the [Transfer Images] button (W-43), the retouching software to which the
image will be transferred is specified. (W-42)

2 Specify the folder for saving the image to be transferred to the retouching software.
(W-42)

3 Specify the information to be displayed below images. Select [File Name] or [Shooting
Date/Time] in the list box.

4 Sets the resolution used when images are transferred to a retouching software such as
Photoshop Elements 2.0. You can specify values between 10 and 2000 pixels per inch.

Specifying the Preferences
You can use the procedure below to specify the settings for image transfer and the processing
parameters used for RAW images when images are transferred and saved.

1 Click the [Preferences] button.
\ The [Preferences] dialog box

appears.

1

2

3

2 Select the [General Settings] tab or the [RAW Image Processing
settings] tab.
\ The selected tab sheet appears.

3 Specify the desired settings and click the [OK] button.
\ The settings are applied and the [Preferences] dialog box closes to end the

procedure.

4
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Specifying the Preferences

8

9

6
7

● You can specify the settings shown below in the [RAW Image Processing
settings] tab sheet.

The settings described here are those shown when [EOS DIGITAL REBEL] / [EOS 300D
DIGITAL] is selected in the [Model Name] list box.

5 Select [EOS DIGITAL REBEL] / [EOS 300D DIGITAL].
* When images shot on a Canon camera are saved in the selected folder or on a CF card

in the connected camera, the camera model is automatically added to the list of camera
models.

6 If you select this option, image adjustment is not performed. Select this option when you
want to use your own retouching software to make fine adjustments to the saturation.

7 Clicking this checkbox neutralizes false colors.
8 When you click this checkbox, a 16% reduced image is shown in the [Preview] mode.
9 Select [8 bits per color channel] or [16 bits per color channel] as the bit rate.

● The buttons listed below are displayed in each of the tab sheets. They
function in the same way in each sheet.

10 Restores the default settings for all the parameters in the currently displayed tab sheet.
11 Applies the specified parameters, closes the [Preferences] dialog box and ends the

procedure.
12 Cancels all the settings, restores the parameters to their original values and ends the

procedure.

5

10

11

12

When you select any other camera in the [Model Name] list box, the available settings
for the respective camera model are displayed.

EOS DIGITAL REBEL /
EOS 300D DIGITAL
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Specifying the Camera Settings
Use the procedure described here to apply the owner name and date and time settings to the
camera. The owner name, and date and time that were applied on the camera are recorded
with the images.
You can also format (initialize) CF cards and check the camera properties data and the status
of the battery and the CF card.

Display the [Camera Settings] dialog box.
● To display this dialog box from File

Viewer Utility, click the [Camera
Settings] button in the main
window.

● To display this dialog box from
RemoteCapture, select [Camera
Settings] from the [Camera] menu
in the Shooting window.

● To display this dialog box from
ZoomBrowser EX, click the [Set]
button in the Camera window and
select [Camera Settings] from the
menu that appears. See Chapter 6
“Working with Images in
ZoomBrowser EX” for information
on how to display the Camera
window.

\ The [Camera Settings] dialog box appears.
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Specifying the Camera Settings

This box shows the
camera model, body ID
(serial number) and
firmware version.

These fields set the
camera owner and the
date and time. You can
enter up to 31 characters
in [Owner’s Name].

The battery level of the
camera is indicated by
[  ] or [  ]. When
the camera is connected to a
household power source
using the DC Coupler Kit
(optional), [  ] is displayed.

This box shows whether
a CF card is loaded in
the camera along with
the available space on
the card and its total
capacity. You can also
format a CF card from
this box.

Applies the specified
settings, closes the [Camera
Settings] dialog box and
ends the procedure.

Cancels all the settings, restores
the parameters to their original
values and ends the procedure.

Applies the settings.

Formatting (initializing) a CF card erases all the data on the card. Because formatting
also erases protected images, you should check the data recorded on the card
carefully before proceeding.
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Specifying the Camera Settings

Setting the Owner’s Name, Date and Time

1 Enter the Owner’s Name.
● Type in the name from your keyboard. You can enter up to 31 characters.

2 Set the Date and Time.
● You can click Date or Time with the mouse and use the [▲] and [▼] buttons to set the

Date and Time, or you can enter the desired date and time from the keyboard.
Clicking the [From PC] button imports the Date and Time data from your computer.

3 Click the [Apply] button.
\ The owner’s name, date and time settings are applied to the camera.
● Once you click the [Apply] button, the settings remain effective until you reset the

owner’s name, date or time.
● Clicking the [OK] button applies the specified settings, closes the [Camera Settings]

dialog box and ends the procedure.
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This chapter describes the operations using the RemoteCapture software,
such as remote shooting, timer shooting and interval timer shooting.
● For more information on using RemoteCapture, refer also to the sources listed

below.
Readme: Click the [Start] button and select [All Programs] ([Programs] in other

versions of Windows) s [Canon Utilities] s [RemoteCapture xx] (“xx”
is the version) s [RemoteCapture Readme].

Help: Displayed by clicking the [Help] button in the Save window.

Operating the Camera from
Your Computer

4
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Starting RemoteCapture

1 Connect the camera to your computer. (W-11)
\ The [EOS Kiss REBEL 300D] screen (event screen) and the [Scanner and Camera

Wizard] dialog box appear.
● Click the [Cancel] button and close all the open windows.

2 Click the [Start] button and select [All Programs] ([Programs] in
other versions of Windows) s [Canon Utilities] s
[RemoteCapture xx] s [RemoteCapture].
● RemoteCapture version information is displayed in xx.
\ The [Connect to camera?] dialog box appears.

3 Click the [Connect] button.
\ The Shooting window and Save

window appear.

Shots to Go
Displays the number of frames that can be saved on
your computer or on the CF card in the camera.

Release button
Takes a shot. The image
is automatically saved on
your computer.
Even when you press the
shutter button on the
camera, the image is
saved on your computer.

Shooting window

Size/Quality list box
Allows you to select the
image recording quality.

Detail setting button
Displays the Detailed Settings window below the Shooting
window allowing you to make various settings. Click the
button again to close the Detailed Settings window.

Menu bar
Displays the [Camera] and [Shooting]
menus.
* You can specify the camera settings

(W-46) in the [Camera] menu.



W-51

O
pe

ra
tin

g 
th

e 
C

am
er

a 
fr

om
 Y

ou
r 

C
om

pu
te

r

W

4

Starting RemoteCapture

Histogram
Shows the
distribution of the
brightness of an
image.

Image
Information
Allows you to
check the image
information
details.

Comments input box
Use this field to type in a comment for the image.

Thumbnail view
Displays thumbnail
images of the
shots taken.

Delete button
Deletes the image selected in
thumbnail view. Deleted images are
completely removed from your
computer. Check images carefully
before deleting them.

View button
Displays the
image selected
in thumbnail view
enlarged in a
separate window.

Disconnect
button
Cuts the
connection to the
camera.

Save window

Image display area
Displays the image selected in the thumbnail view.

The [RAW] symbol is
displayed for RAW images.
No symbol is shown for
JPEG images.

* The above window shows all the information at once. In actual use, only the
information needed is displayed.

● To exit RemoteCapture, click the [Disconnect] button and select [Exit] from the [File]
menu.

Menu bar
Displays the [File], [Edit], [View],
and [Help] menus.
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4 Click the [Release] button.
\ The captured image is saved to your computer and displayed on the screen.
● To enlarge the image for checking, select the image and click the [View] button.
● To delete the image, select the image and click the [Delete] button.

Using RemoteCapture
You can control the camera from your computer and take single-frame shots, timer shots and
interval timer shots. The images are automatically saved on your computer.
Shots taken with RemoteCapture and saved on your computer can be displayed and
processed in File Viewer Utility in the same way as images shot with the camera.

Before you use RemoteCapture, be sure to confirm that the camera is ready for
shooting. If the camera is not ready for shooting (the lens is not attached, etc.),
you cannot perform the operation as shown below.

Taking Shots from Your Computer

1 Set the camera up ready to shoot.

2 Make various settings.
● For information on how to set the size and image quality, refer to “Shooting window”

(W-50).
● See “Default Settings” (W-55) for information on how to save images.

3 Take a test shot.
● Click [ ] (the Detail setting button) in the Shooting window and select the [Angle

adjustment] tab in the displayed Detailed Settings window, and then click the [Test
Shot] button.

\ The test-shot image is displayed in the test-shot image display area.

Test-shot image
display area
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Using RemoteCapture

● With the auto focusing, if the camera cannot focus, you cannot take shots.
If you cannot take shots with the auto focusing, focus manually and then take a
shot.

● The test-shot images taken with the camera held vertically are displayed in the
normal (horizontal) orientation in the test-shot image display area.

● If you use RemoteCapture to take shots while you are using the Windows Explorer
in the WIA Driver to display images on the camera, RemoteCapture may not
operate correctly.

To rotate a downloaded image, select the image and then select [Rotate Saved Image
90 degree Right] or [Rotate Saved Image 90 degree Left] in the [Edit] menu.

Approximate Transfer Times

Timer Shooting
Use this function to specify the timer delay. Timer shooting shots are then taken after the
specified number of seconds.

1 Click [ ] (the Detail setting button) in the Shooting window and
select the [Timer shooting] tab.
\ The [Timer shooting] tab sheet in the Detailed Settings window appears.

2 Enter the timer setting (in seconds) and click the [Start] button.
● You can set a value between 2 and 30 seconds in 1-second increments.
\ Timer shooting shots are taken after the specified number of seconds.

Transfer Time Approx. 54 sec.

• The transfer times given here are only approximations. Actual transfer times vary
widely depending on the images and the computer system.

• Transfer times are based on Canon testing standards.
(Time until the RAW image appears in the Save window when the [Release] button is
pressed in the Shooting window and [Computer only] is specified using the following: OS:
Windows XP; CPU: 2.2 GHz Pentium 4; RAM: 256 MB)

• The times for images shot in JPEG format will be shorter than those shown above.



W-54

Using RemoteCapture

Checking Shooting Settings
You can confirm the camera settings used when images are taken.

Click [ ] (the Detail setting button) in the Shooting window and
select the [Shooting Settings] tab.
\ The camera settings used when images are taken are displayed.

Interval Timer Shooting
This function allows you to specify the interval between shots and the number of shots.

1 Click [ ] (the Detail setting button) in the Shooting window and
select the [Interval Timer Shooting] tab.
\ The [Interval Timer Shooting] tab sheet in the Detailed Settings window appears.

2 Enter the shooting interval and the total number of shots. Then
click the [Start] button.
● You can set a shooting interval between 5 seconds and 60 minutes in 1-second

increments.
● You can set up to a maximum of 9999 shots.
\ Interval timer shooting is performed using the specified interval between shots and

the specified number of shots.

Depending on the available capacity on your computer’s hard disk, the maximum
number of available shots that can be set may be less than 9999. You can check the
number of shots that can be set by referring to the number of available shots shown in
the Shooting window. (W-50)

On some types of computers, if you set a short interval between shots and there is
insufficient time to download and save the images, it may not be possible to take shots
at the specified interval. If this occurs, set a longer interval between shots and take the
shots again.

Printing Images
You can print images. All the images shown in the thumbnail view are printed in index format.
The time of shooting and the file names are printed with the images.

1 Select [Print Index] in the [File] menu in the Save window.
\ The Printer Setup dialog box appears.

2 Select the printer to be used, specify the print settings and print
images.
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Setting RemoteCapture
This section describes how to make various settings for using RemoteCapture. In the settings,
you can specify Default Settings to save images on your computer, and you can also specify
Detailed Settings to make shooting settings from your computer remotely.

Default Settings
Use the procedure below to select the folder in which images will be saved and to specify the
file names.

1 Select [Preferences] in the [File] menu in the Save window.
\ The [Preferences] dialog box appears.

2 Specify the desired settings and click the [OK] button.
\ The settings are saved and the [Preferences] dialog box closes to end the procedure.

3

4

8

1
2

5

6

7
9
10
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Setting RemoteCapture

You can set the Hotkey for shutter release by selecting the [Release Hotkey] tab.

1 You can use this option to take shots when there is no CF card in the camera or when the
CF card is full.

2 Saves captured images both on your computer and on the CF card in the camera.
3 Use this field to enter a file name when saving a captured image.

* The file name can consist of up to 16 characters.
4 Sets the number of digits in the sequence number that follows the file name and the

starting number used.
* If you enter [Capture] into [File Prefix] field, [5] into [Number of Digits], and [1] into [Start],

sequential file names will be assigned automatically beginning with [Capture_00001.jpg]
or [Capture_00001.crw].

5 Displays the directory path for the folder in which files are saved.
6 Displays the folder where the files will be saved in tree format.
7 Use this to select the drive on which files are saved.
8 Creates a new folder.
9 Applies the specified settings, closes the [Preferences] dialog box and ends the

procedure.
10 Cancels all the specified settings, restores the previous settings and ends the procedure.
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Setting RemoteCapture

1

2 3

4

Detailed Settings
You can set shooting settings, such as White Balance and Exposure Compensation, from your
computer remotely.

● Before you make detailed settings, be sure to confirm that the camera is
ready for shooting. If the camera is not ready for shooting (the lens is not
attached, etc.), you cannot make some of the settings.

● The shooting settings cannot be specified if the camera’s shooting mode is
set to the Basic zone. Set the camera’s shooting mode to the Creative zone.

1 Display the Detailed Settings window.
● Click [ ] (the Detail setting button) in the Shooting window.

2 Click the [Shooting modes adjustment] tab.
\ The [Shooting modes adjustment] tab sheet appears.

3 Specify the settings and then close the Detailed Settings window.
● Click  [ ] (the Detail setting button) in the Shooting window.

* The above window shows all the information at once. In actual use, only the
information needed is displayed.
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Setting RemoteCapture

1 Allows you to specify White Balance.
2 Allows you to perform Exposure Compensation.

(Enabled only when Program AE, Shutter-priority AE, Aperture-priority AE or Automatic
Depth-priority AE is selected as the shooting mode on the camera.)

3 Allows you to specify ISO Speed.
4 Allows you to specify the Av (aperture value) and Tv (shutter speed) settings.

(The specifiable settings are only displayed when Shutter-priority AE, Aperture-priority AE
or Manual Exposure is selected as the shooting mode on the camera.)
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This chapter describes a simple procedure for downloading JPEG images
using the WIA Drivers for Windows XP and Windows Me, the TWAIN
Drivers for Windows 2000 and Windows 98 SE, and the PTP connection
mode (supported on Windows XP only).
● A number of restrictions apply to the WIA Driver. You must read the “WIA Driver

Readme” file before using the WIA Driver.
Readme: Click the [Start] button and then select [All Programs] ([Programs] on

Windows Me) s [Canon Utilities] s [EOS Kiss REBEL 300D WIA Driver]
s [WIA Driver Readme].

● For more information on using the TWAIN Driver, refer also to the sources listed
below.
Readme: Click the [Start] button and select [Programs] s [Canon Utilities] s

[EOS Kiss REBEL 300D TWAIN Driver] s [TWAIN Driver Readme].
Help: Displayed by clicking the [Help] button in the TWAIN Driver main

window.

Downloading JPEG Images
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Downloading Images with the WIA Driver
You can download only JPEG images using the wizard, Windows Explorer or the WIA TWAIN
driver. Windows XP users can use the same procedure to download JPEG images using the
PTP function. To download and process RAW images, use the File Viewer Utility described in
Chapter 3.

Downloading with [Scanner and Camera Wizard]
You can quickly and easily download JPEG images to your computer by following the Wizard’s
on-screen instructions.

1 Connect the camera to your computer. (W-11)
\ The [EOS Kiss REBEL 300D] screen (event screen) appears. Select [Microsoft

Scanner and Camera Wizard], and then click the [OK] button. The [Scanner and
Camera Wizard] dialog box appears.

\ If you are using Windows Me, the [Scanner and Camera Wizard] dialog box appears.

2 Click the [Next] button.
\ The [Choose Pictures to Copy] window appears in the [Scanner and Camera Wizard]

dialog box.
\ If you are using Windows Me, the [Choose Pictures] window appears in the [Scanner

and Camera Wizard] dialog box.

3 Select the image(s) you wish to download and click the [Next]
button.
● To select multiple images, press

and hold the <Ctrl> or <Shift> key
on the keyboard while clicking on
images. To select all the images,
click the [Select All] button.

\ The [Picture Name and
Destination] window appears in the
[Scanner and Camera Wizard]
dialog box.

\ If you are using Windows Me, the
[Save Pictures] window appears in
the [Scanner and Camera Wizard]
dialog box.



W-61

D
ow

nl
oa

di
ng

 J
P

E
G

 Im
ag

es

W

5

Downloading Images with the WIA Driver

4 Specify a file name and save location and click the [Next] button.
\ The selected images will be downloaded to the specified destination folder and the

[other option] window appears in the [Scanner and Camera Wizard] dialog box.
\ If you are using Windows Me, when you specify the file name and destination folder

and then click the [Finish] button, the images are downloaded and the [Scanner and
Camera Wizard] dialog box closes.

● If you do not specify a save location, a new folder is created in the [My Picture] folder
(the [My Pictures] folder in Windows Me) and the images are saved in the new folder.

5 Select the [Nothing. I’m finished working with these pictures]
radio button and click the [Next] button.
\ The [Completing the Scanner and Camera Wizard] window appears in the [Scanner

and Camera Wizard] dialog box.

6 Click the [Finish] button.
\ The [Scanner and Camera Wizard] dialog box closes.

RAW images are displayed by the WIA TWAIN driver but cannot be downloaded. To
download and process RAW images, use the File Viewer Utility described in Chapter
3.
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Downloading Images with the WIA Driver

If you use RemoteCapture to take shots while you are using Windows Explorer to
display images on the camera, RemoteCapture may not operate correctly.

Downloading with Windows Explorer
JPEG images can be downloaded to the computer with Windows Explorer just as you would
copy any other file.

1 Connect the camera to your computer. (W-11)
\ The [EOS Kiss REBEL 300D] screen (event screen) and the [Scanner and Camera

Wizard] dialog box appear.
● Click the [Cancel] button and close all the open windows.

2 Start up Windows Explorer and select a folder.
● You can start Windows Explorer by

right-clicking the [Start] button and
selecting [Explorer] from the menu
that appears.

● Double-click [EOS Kiss REBEL
300D] in the Explorer view and
click the [100CANON] folder, or
click the [+] on the left and then
click the [100CANON] folder.

● Windows Me users should double-
click [EOS Kiss REBEL 300D] in
the Explorer view and then double-
click the [100CANON] folder icon
that appears.

● A number between 100 and 999 is displayed in place of the “100” in [100CANON].
\ The camera’s images will be displayed as thumbnails in the Explorer window.

3 Save the images on your computer.
● Download by Specifying a Folder

If you right-click a displayed image, select [Save in My Picture] from the menu that
appears and then click the [OK] button, the image is saved in the [My Picture] folder
(the [My Pictures] folder in Windows Me).

● Download by Dragging and Dropping
Select an image in the Explorer window, drag it to the target folder and drop it.
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Downloading Images with the WIA Driver

Downloading with the WIA TWAIN
This section describes how to use the TWAIN Driver-compatible retouching software, select
images via the WIA TWAIN driver and import them into your program. The description given
here use Photoshop Elements 2.0, as an example.

1 Connect the camera to your computer. (W-11)
\ The [EOS Kiss REBEL 300D] screen (event screen) and the [Scanner and Camera

Wizard] dialog box appear.
● Click the [Cancel] button and close all the open windows.

2 Start Photoshop Elements 2.0.
● Click the [Start] button and select [All Programs] ([Programs] on Windows Me) s

[Adobe Photoshop Elements 2.0].

3 Select the [File] menu s [Import] s [WIA-EOS Kiss REBEL
300D].
\ The [Get Pictures from] dialog box appears.

4 Double-click the [100CANON] folder.
● A number between 100 and 999 is displayed in place of the “100” in [100CANON].

5 Select the image(s) you wish to download and click the [Get
Pictures] button.
\ The selected image(s) will be

downloaded to the software.

RAW images are displayed by the WIA TWAIN driver but cannot be downloaded. To
download and process RAW images, use the File Viewer Utility described in Chapter
3.

The method for starting the application and the dialog box contents differ depending
on your retouching software. Refer to the User’s Manual provided with your retouching
software for details.
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This explanation uses Photoshop Elements 2.0 as an example to describe the procedures for
downloading images from the camera and transferring.
If you are using other application, refer to the User’s Manuals provided with your software for
information on setting up and using TWAIN devices.
● The TWAIN Driver is started from a TWAIN Driver-compatible application. Only JPEG

images can be downloaded using the TWAIN Driver. To display or process RAW images,
use File Viewer Utility described in Chapter 3.

1 Connect the camera to your computer. (W-11)
\ The [EOS Kiss REBEL 300D] screen (event screen) appears.
● Click the [Cancel] button and close all the open windows.

2 Start Photoshop Elements 2.0.
● Click the [Start] button and select [Programs] s [Adobe Photoshop Elements 2.0].
\ Photoshop Elements 2.0 starts up.

3 Select the [File] menu s [Import] s [Canon EOS Kiss REBEL
300D USB].
\ The TWAIN Driver starts and the

JPEG image saved on the CF card
in the camera is displayed.

● To exit the TWAIN Driver, select
[Exit] from the [File] menu.

Downloading Images with the TWAIN Driver

4 Select the image to be transferred and select [Transfer Images]
from the [File] menu.
\ The image transferred to Photoshop Elements 2.0 is displayed.

You can also transfer images by double-clicking a displayed thumbnail image.
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6This chapter explains how to use ZoomBrowser EX to perform a range of
operations including downloading the camera’s images, printing them, and
sending e-mail with downloaded images as file attachments.
● For more information on using ZoomBrowser EX, refer also to the sources listed

below.
Readme: Click the [Start] button and select [All Programs]

([Programs] in other versions of Windows) s [Canon
Utilities] s [ZoomBrowser EX] s [ZoomBrowser EX
README].

Help: Displayed by clicking the [Help] button in the ZoomBrowser
EX main window.

Software User Guide: View by downloading from the Canon website. See
“ZoomBrowser EX/ImageBrowser Software User Guide”
(A-7) for details.

Working with Images in
ZoomBrowser EX

6



W-66

Deselects images.

Starting ZoomBrowser EX
ZoomBrowser EX can be started from the event screen that appears when you connect the
camera to your computer, or by clicking the desktop icon or the [Start] button.

Starting ZoomBrowser EX from an Event
Screen

Start up ZoomBrowser EX from the [EOS Kiss REBEL 300D] screen (event screen) that
appears when you connect the camera to your computer.

1 Connect the camera to your computer. (W-11)
\ The [EOS Kiss REBEL 300D] screen (event screen) appears.
\ In Windows Me, the [Scanner and Camera Wizard] dialog box appears. Click the

[Cancel] button to exit the [Scanner and Camera Wizard] dialog box and start
ZoomBrowser EX (see “Starting ZoomBrowser EX Using the Icon” (W-67).)

2 Select [Canon ZoomBrowser EX] and click the [OK] button.
\ ZoomBrowser EX starts up and the Camera window appears.
● The images saved on the CF card in the camera or card reader are displayed in the

Camera window.

Camera Window

The [RAW] symbol
is displayed for
RAW images

Automatically attaches images to an e-mail.

Displays images as a slideshow.

Prints images.

Downloads images to the computer.

Camera reconnection, the camera
settings (W-46) and the slideshow,
edit of DPOF print settings
information.

Displays the Camera window
Help and version information.

Rotates images 90° or 180° left or right.

Deletes images.Selects all images with
the specified condition.

Displays the image information.
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Starting ZoomBrowser EX

Starting ZoomBrowser EX Using the Icon
If ZoomBrowser EX was not started when you connected the camera to your computer (e.g. if
you started File Viewer Utility when you connected the camera to your computer) and you
want to download images from a card reader, start ZoomBrowser EX from the desktop icon or
by clicking the [Start] button.

1 Double-click the [ZoomBrowser EX] icon on the desktop.
● You can also start ZoomBrowser EX by clicking the [Start] button and selecting [All

Programs] ([Programs] in other versions of Windows) s [Canon Utilities] s
[ZoomBrowser EX] s [ZoomBrowser EX].

\ ZoomBrowser EX starts up and the ZoomBrowser EX main window appears.

ZoomBrowser EX main window

Folders area Function buttons

Browser area
Displays the images in the folder
selected in the Folders area.

Automatically attaches images to an e-mail.

Displays images as a slideshow or edits images
using third-party retouching software.

Starts PhotoRecord and prints images.

Opens the Camera window. When
RemoteCapture is running (W-50), [Remote
Shooting] is added to the menu.
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Starting ZoomBrowser EX

2 Click the [Camera & Memory Card] button and select [Browse/
Download images] from the menu that appears.
\ The ZoomBrowser EX main window closes and the Camera window opens.
● The images saved on the CF card in the camera or card reader are displayed in the

Camera window.

Resizes the images displayed in the Browser area.
If you click the [       ] button and then click the
desired image or folder, the image or folder is
displayed enlarged. Clicking the [       ] button
displays the image or folder at reduced size.
(These options are displayed when Zoom mode is
selected.)

Function Buttons

Switches between Zoom mode and Scroll mode for Browser area display.

Resizes the images displayed in the Browser area
(available when Scroll mode is selected).

Enlarges and displays an image in another window.

Displays the image information.

Rotates images 90° or 180° left or right.

Deletes images.

Displays the next folder level up
from the folders currently displayed
in the Browser area.

Deselects images.

Selects all the images at once.
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Downloading and Saving Images
The procedure below describes how to download the images saved on a CF card in the
camera or card reader and save those images on your computer.

1 Select the images to be downloaded from the Camera window
and click the [Download image] button.
● Click the displayed images to select them. You can also select multiple images by

clicking images successively.
● Click a selected image again to deselect the image.
\ The [Download Settings] dialog box appears.
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Downloading and Saving Images

Creates a new folder
inside the selected
folder and saves
images to that folder.

2 Specify the desired settings and click the [OK] button.
\ The images are saved on your computer, the Camera window closes and the

ZoomBrowser EX main window opens.
\ The downloaded images are displayed in the ZoomBrowser EX main window.

Sets the file name used when images are saved.
Clicking the [Designate prefix of image to be saved] checkbox
allows you to enter any file name in the [File prefix] field. Image files
are named using the [Entered-file-name 0001.JPG] format. If you
deselect the checkbox, the file name is [100-0001.jpg].

Saves images in the selected folder.

Selects the folder in
which images are
saved. The selected
folder appears in the
[Save to folder] field.

Sets the folder name
used when the [Create
new folder] radio button
is selected.
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Printing Images in PhotoRecord
In ZoomBrowser EX, the PhotoRecord window is used to print images. In addition to the
printing modes supported in Exif 2.2 (ExifPrint), PhotoRecord also supports layout printing and
index printing.

Printing Images

1 Select the images to be printed in the ZoomBrowser EX main
window or the Camera window.

2 Click the [Print] button and select [Layout Print] or [Index Print].
\ In the ZoomBrowser EX main

window, a window appears in
which you can select the
information to be printed with the
images.

\ The [Download Settings] dialog box
(W-70) appears in the Camera
window. Specify the desired
settings and click the [OK] button. A
window then appears in which you
can select the information to be
printed with the images.

3 Click the checkboxes for the information to be printed with the
image ([Comment], [File name] and [Date and Time]) and then
click the [Finish] button.
\ If you selected [Layout Print] in step 2, PhotoRecord starts up and the [PhotoRecord

Print Modes] dialog box appears.
\ If you selected [Index Print] in step 2, the [Index Print Settings] dialog box appears.

Set the printer and paper settings and then click the [Print] button to begin printing.
● You can select multiple items of information to be printed with an image.
● You can enter a comment by selecting the image displayed in the ZoomBrowser EX

main window, clicking the [Properties] button and entering your comment in the
window displayed.
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Printing Images in PhotoRecord

* The print mode settings vary depending on your printer.

Automatically adjusts the image layout.
Arranges the images as an index.
Allows all the images to be arranged
manually.

4 Select the print mode and click the [Next] button.
\ The Page Setup window appears.
● This explanation describes the procedure when the [Artwork/Layout album] radio

button is selected.

Select this option when you want to
print on the Canon perforated paper.
(This option is not displayed if you are
using a printer that does not support
printing on perforated paper.)

Selecting the [Artwork/Layout album] radio button allows you to set any position or
size for your printed images. Other print modes allow you to print tiled images or print
on Canon perforated paper.

5 Set the paper type, paper size and orientation, and then click the
[Next] button.
\ The layout settings window appears.
● Do not select [Custom] in the

[Paper Size] list box. Depending on
the printer you are using, this could
prevent the image from being
printed correctly.

6 Select the layout mode and click the [Finish] button.
\ The PhotoRecord window appears.

Select this option to create prints
with colorful and attractive designs.

Select this option to print as many
images as possible on a set paper size
(such as L-size or business-card-size).

Prints the number of images
specified per page laid out so that
they cover the entire page.
(When a printer that doesn’t support
borderless full-screen printing is used,
[Tiled photo printing] is displayed.)
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Printing Images in PhotoRecord

Opens the [Print Mode]
dialog box and allows you
to change the settings. See
steps 4 to 6 for information
on specifying the settings.

7 Edit the print window and click the [Print] button.
\ The [Print] dialog box appears and the image is printed.

● Saving the page layout
You can save the page layout as an “Album” by selecting [Save As] from the [File] menu.

● Adding images to the page
You can drag and drop displayed images from the ZoomBrowser EX main window to the
PhotoRecord window.

PhotoRecord Window

Images can be moved
by dragging them to the
desired position.

You can enter a title by
clicking the [Options] button
and selecting [Title] s [Edit]
from the menu that appears.

Changes the image
sequence.

You can insert a text box by
clicking the [Options] button
and selecting [Add Text]
from the menu that appears.
You can also change the text
decorations and the text
itself by right-clicking a text
box on the screen and
selecting an option from the
menu that appears.

Options button
Displays the menu
options used to edit
the window.

You can enter a heading by
right-clicking the image and
selecting [Caption] s [Edit]
from the menu that appears.

Changes the image size.

Select [AUTO], [INDEX]
or [MANUAL] as the
layout method.

Stops image downloading

Displays the [Print] dialog
box and prints the page.

Cancels the last action performed so that
you can redo the action.

Opens the [Change Page Artwork] dialog box and allows
you to change settings such as the decorative design and
the colors used.

Opens the [Fetch Photos] dialog box and downloads new images on the
next page.

Images are not saved in the album data. Accordingly, you should not delete images or
move images out of the folder in which they were saved when you created the album.
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Printing Images in PhotoRecord

● Changing the decorations for the entire page
To select your preferred decorative design, open the [Change Page Artwork] dialog
box by clicking the [Options] button and selecting [Change Page Artwork] from the
menu that appears.

● Changing the image frames
To select your preferred frame, open the [Change Photo Frame] dialog box by right-
clicking the image and selecting [Change Photo Frame] from the menu that appears.

● Changing the image size and angle
You can change size and angle of an image by moving the cursor over the image
and dragging the displayed arrows and buttons.

Switches from Rotate
mode to Enlarge/
Reduce mode.

* Depending on the print mode, you may not be able to change image size or angle.

● Changing the number of images displayed per page
You can change the number of images displayed on each page using the [Number of
Photos per page when fetching] setting in the [Preferences] dialog box that appears
when you select [Preferences] from the [Edit] menu.

8 Click the [Print] button.
\ Printing begins.

If you are using a network printer and the printer name exceeds 31 characters when
the path name is included, it may not be possible to print from PhotoRecord. If this
problem occurs, open the Control Panel and select [Printers and other hardware] s
[Printers and Faxes] (In other versions of Windows select [Printer] from the Control
Panel). Then change the path and printer name so that it is no longer than 31
characters.

Drag this arrow to
change the image size.

Drag this arrow to change the image angle.

Enlarge/Reduce mode Rotate mode

Switches from Enlarge/
Reduce mode to Rotate
mode.

Displays the screen operations menu.
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Printing Images in PhotoRecord

Adjusting the Image Quality and Printing
(Exif 2.2 compatible)

PhotoRecord includes an image quality adjustment function that is compatible with Exif 2.2
(Exif Print).
This function allows you to print images with the quality automatically corrected.

1 Open the PhotoRecord window. (W-73)

2 Right-click the image to be printed and select [Clip/Correct
Photo] from the menu that appears.
\ The enlarged image appears in a

separate window and the [Photo
Control Panel] opens.

3 Click the [Exif Print] checkbox in the [Photo Control Panel] and
then click the [CLOSE] button.
\ The selected image is corrected.

Images shot on camera that comply with Exif 2.2 incorporate recorded information on
the settings used when the shot was taken. The Exif Print correction functions use this
information to adjust the image quality so that it more accurately reflects the shooting
settings.
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Sets the quality of the image sent. (Lower quality will
result in a rougher image but a smaller file size.)

Sending E-mail with Attached Images
Use the procedure below to attach images saved on your computer to e-mail messages and
then send the mail.

To automatically start your e-mail software from ZoomBrowser EX and send images,
your e-mail software must be set as a MAPI client. Refer to the user manuals for your
e-mail software for information on MAPI settings.

1 Display an image in the ZoomBrowser EX main window. (W-69)

2 Select the image to be sent in the Browser area.

3 Click the [Internet] button and then select [Email Images] from
the menu that appears.

4 Set the image size and quality and then click the [Next] button.

Select this option to retain the image size and quality
when sending the image.

Select this option to
reduce the file size
when the image is sent.

Sets the size of the image (number of pixels) sent.

Allows you to check the
image file size after
compression (displayed as
[Total size of changed
images]).

Displays the compressed
image in a separate
window so you can check
the image.
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Sending E-mail with Attached Images

5 Select to send an e-mail message immediately or to save the
image and send the mail later and then click the [Finish] button.

● When the [Create a new email] radio button is selected, the e-mail software starts up
and the window for sending an e-mail message appears with the image already
specified as an attachment.

\ Enter the address and a message and then send the e-mail.
● If the [Save the images in a folder to send through an email program that dose not

support MAPI] radio button is selected, click the [Browse] button and specify the
folder where the image is to be saved.

\ The images are saved in the specified destination folder.

Automatic e-mail software starting is only supported for e-mail software that supports
MAPI. If your e-mail software does not support MAPI, save the image and start the e-
mail software before attaching the image to the outgoing e-mail.

MAPI (Messaging Application Programming Interface) is an e-mail software function
adopted as a standard by Microsoft Corporation.
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Processing RAW Images and Merging Images
Processing RAW Images with ZoomBrowser EX

To process RAW images from ZoomBrowser EX, start up File Viewer Utility.

1 Display an image in the ZoomBrowser EX main window. (W-69)

2 Select the RAW image to be processed from the Browser area.

3 Click the [View & Modify] button and select [Process RAW image]
from the menu that appears.
\ File Viewer Utility starts, and the thumbnail-displayed RAW image is displayed in the

File Viewer Utility main window.

If File Viewer Utility is started from ZoomBrowser EX, the functions available in File
Viewer Utility are restricted. In addition to that [Tree View Area] is not displayed, the
functions such as the camera settings, image rotation, image transfer, index saving,
image erasing, information update, image protection, etc. cannot be used.

Merging Images with PhotoStitch
PhotoStitch makes it easy to created composite images such as panorama shots by
automatically merging multiple images.

1 Display images in the ZoomBrowser EX main window. (W-69)

2 Select the desired JPEG images from the Browser area, click the
[View & Modify] button and select [Stitch Photos] from the menu
that appears.
\ PhotoStitch starts up.
● Follow the instructions in the guidance window to merge the images.
● Please refer to the PhotoStitch Help menu for more details.

● You cannot merge RAW images in PhotoStitch.
● Up to four images can be merged using PhotoStitch.
● You will need QuickTime 3.0 or later to save composite images made using

PhotoStitch in the QuickTime VR format. If QuickTime 3.0 or later is not already
installed on your computer, obtain and install it separately.
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This chapter provides a troubleshooting manual and describes the
software uninstallation procedures.

Troubleshooting and
Uninstallation
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When the “Could not complete installation correctly” or “Communication between the camera
and computer failed” message appears, check the items described below.
● The EOS Kiss REBEL 300D is shown in the operation screens as “EOS XXX”.

Installation failed.
● If you are using Windows XP Professional or Windows 2000, are you using

the computer under a user setting other than [Computer administrator] or
[Administrator]?
➞ You cannot install software if a user setting other than [Computer administrator] or

[Administrator] is selected. Select the [Computer administrator] user setting in Windows
XP Professional or the [Administrator] user setting in Windows 2000. For detailed
information on selecting the user setting, refer to the manuals supplied with your
computer.

● Have you installed the WIA Driver or TWAIN Driver?
➞ Even if you connect the camera to the computer, installation is not completed unless you

have installed the WIA Driver or TWAIN Driver. Insert the SOLUTION DISK into the CD-
ROM drive and install the WIA Driver or TWAIN Driver before connecting the camera to
your computer.

● Is the cable firmly plugged into its socket?
➞ To complete the installation, ensure that the plugs on the dedicated USB cable are

securely plugged into the ports on the camera and computer when you connect the
camera to your computer. (W-11)

I have installed the software but the camera and
computer cannot communicate.

● Is the driver installed?
➞ The driver is required for communications between the camera and computer. When you

use the SOLUTION DISK software to communicate between the camera and computer,
be sure to install the driver shown below appropriate to your windows.
• Windows XP/Windows Me: WIA Driver
• Windows 2000/Windows 98 SE: TWAIN Driver

● Does your computer comply with these requirements?
➞ PC with Windows XP, Windows 2000, Windows Me or Windows 98 SE preinstalled and a

USB port as a standard feature. (A-8)
* Operation is not guaranteed when a USB connection is used on computer systems

other than those listed above.

● Are the camera and computer connected correctly?
➞ Connect the camera to your computer correctly using the dedicated USB cable. (W-11)

● Is the correct communication mode selected on the camera?
➞ To use the SOLUTION DISK software, set the camera’s communication mode to

[Normal]. If you are using the PTP connection in Windows XP, set the mode to [PTP] (W-
10).

Troubleshooting
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Troubleshooting

➞ If [EOS Kiss REBEL 300D] is not displayed, the driver is not operating normally. Briefly
disconnect and then reconnect the dedicated USB cable, ensuring that the connection is
secure. If [EOS Kiss REBEL 300D] still does not appear, use the following procedure to
re-install the driver.
1 Disconnect the dedicated USB cable and uninstall the driver. (W-84)
2 Re-install the driver. (W-4)

➞ When the [X], [!] or [?] symbol is displayed beside [EOS Kiss REBEL 300D], part of the
driver is missing or corrupted. Use the following procedure to re-install the driver.
1 Delete [EOS Kiss REBEL 300D] displayed in [Imaging devices].
2 Disconnect the dedicated USB cable and uninstall the driver. (W-84)
3 Re-install the driver. (W-4)

● Is the driver installed correctly?
Connect the camera to your computer with the dedicated USB cable and set the camera’s
power switch to <ON> (W-11) and open [Device Manager] (below). Click the plus symbol [+]
to the left of [Other devices] or [Unknown devices] and check whether [EOS Kiss REBEL
300D] or [Canon Digital Camera] is displayed.

● Is there sufficient charge left in the camera battery?
➞ Your computer does not supply power to the camera. Connect the DC Coupler Kit

(optional) to the camera or load a fully charged battery into the camera before
connecting it to your computer. (“Installing and Removing the Battery” in the Instructions
provided with your camera)

● Do you have more than one camera connected to your computer?
If you connect more than one camera to the same computer, the driver and camera may not
operate normally.

➞ Close the software and disconnect all the dedicated USB cables. Then reconnect just the
dedicated USB cable that connects the camera to your computer.

● Is the driver operating normally?
Connect the camera to your computer
with the dedicated USB cable and set the
camera’s power switch to <ON> (W-11)
and open [Device Manager] (W-82). Click
the plus symbol [+] to the left of [Imaging
devices] and check that [EOS Kiss
REBEL 300D] is displayed.
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➞ If [EOS Kiss REBEL 300D] or [Canon Digital Camera] is displayed in [Other devices] or
[Unknown devices], the driver was not installed correctly. Use the following procedure to
re-install the driver.

1 Delete [EOS Kiss REBEL 300D] or [Canon Digital Camera] displayed in [Other
devices] or [Unknown devices].

2 Disconnect the dedicated USB cable and uninstall the driver. (W-84)
3 Re-install the driver. (W-4)

To Display the Device Manager

● Windows XP
➞ Click the [Start] button and select [Control Panel] s [Performance and Maintenance] s

[System]. Then select the [Hardware] tab and click the [Device Manager] button.

● Windows 2000
➞ Click the [Start] button and select [Settings] s [Control Panel]. Then double-click the

[System] icon to open and select the [Hardware] tab and click the [Device Manager]
button.

● Windows Me and Windows 98 SE
➞ Click the [Start] button and select [Settings] s [Control Panel]. Then double-click the

[System] icon to open and select the [Device Manager] tab.

I connected the camera to the computer before installing
the software

● Did you set the camera’s power switch to <ON>?
➞ If you did not set the camera’s power switch to <ON>, proceed as follows:

1 Disconnect the dedicated USB cable from the camera and computer.
2 Install the SOLUTION DISK software on your computer using the correct installation

procedure and then connect the camera to your computer to complete the installation.
(W-4)

➞ If you set the camera’s power switch to <ON>, proceed as follows:
1 If [Found New Hardware Wizard] or any other dialog boxes appear, click the [Cancel]

buttons to cancel all the dialog boxes.
2 When you have canceled all the dialog boxes, set the camera’s power switch to

<OFF>.
3 Disconnect the dedicated USB cable from the camera and computer.
4 Install the SOLUTION DISK software on your computer using the correct installation

procedure and then connect the camera to your computer to complete the installation.
(W-4)
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Uninstalling
● Before beginning the software uninstallation, close all programs you are using and

disconnect the dedicated USB cable from your computer.

Uninstalling (Deleting) the Software
The following explanation uses the procedures for uninstalling File Viewer Utility as an
example for uninstalling other programs as well.
● For information on uninstalling the WIA Driver or TWAIN Driver, see “Uninstalling the

Driver”. (W-84)
● Windows XP Professional or Windows 2000 users should log in using computer

Administrator privileges.
● To prevent computer malfunctions, always restart your computer after you have uninstalled

the software. Re-installing the software without first restarting your computer is particularly
likely to result in computer malfunctions.

1 Click the [Start] button and select [All Programs] ([Programs] in
other versions of Windows) s [Canon Utilities] s
[FileViewerUtility xx] s [FileViewerUtility Uninstall].
● File Viewer Utility version information is displayed in xx.

2 Proceed with the uninstallation as directed by the on-screen
messages.
\ Software is uninstalled.



W-84

Uninstalling

Uninstalling the Driver
To uninstall the driver, you must first uninstall the WIA Driver or TWAIN Driver, then remove
[EOS Kiss REBEL 300D] from the [Scanners and Cameras Properties] dialog box or the
[Scanners and Cameras] dialog box, and then delete the driver settings files.
● Windows XP Professional or Windows 2000 users should log in using computer

Administrator privileges.
● To prevent computer malfunctions, always restart your computer after you have uninstalled

the driver. Re-installing the driver without first restarting your computer is particularly likely
to result in computer malfunctions.

● The EOS Kiss REBEL 300D is shown in the operation screens as “EOS XXX”.

1 Uninstall [EOS Kiss REBEL 300D WIA Driver] or [EOS Kiss
REBEL 300D TWAIN Driver].
● If you are using Windows XP or Windows Me, click the [Start] button and then select

[All Programs] ([Programs] on Windows Me) s [Canon Utilities] s [EOS Kiss REBEL
300D WIA Driver] s [WIA Driver Uninstall].

● If you are using Windows 2000 or Windows 98 SE, click the [Start] button and then
select [Programs] s [Canon Utilities] s [EOS Kiss REBEL 300D TWAIN Driver] s
[TWAIN Driver Uninstall].

2 Proceed with the uninstallation as directed by the on-screen
messages.
\ The driver is uninstalled.

3 Connect the camera to your computer.
● If the [EOS Kiss REBEL 300D] screen (event screen) or the [Scanner and Camera

Wizard] dialog box appears, click the [Cancel] buttons to close all open windows.

4 Click the [Start] button s [Control Panel] s [Printers and other
hardware].
● In Windows versions other than Windows XP, click the [Start] button and then select

[Settings] s [Control Panel].

5 Click [Scanners and Cameras].
\ If you are using Windows XP or Windows Me, the [Scanners and Cameras] dialog

box appears.
● In Windows versions other than Windows XP, double-click the [Scanners and

Cameras] icon.
\ If you are using Windows 2000 or Windows 98 SE, the [Scanners and Cameras

Properties] dialog box appears.
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Uninstalling

6 Delete [EOS Kiss REBEL 300D].
● If you are using Windows XP or

Windows Me, select and right-click
[EOS Kiss REBEL 300D] icon and
then select [Delete] from the menu
that appears. When the
confirmation message appears,
click the [Yes] button.

● If you are using Windows 2000 or
Windows 98 SE, select [EOS Kiss
REBEL 300D] and click the
[Remove] button.

● Once [EOS Kiss REBEL 300D] is
no longer displayed in the
[Scanners and Cameras
Properties] dialog box or the
[Scanners and Cameras] dialog
box, close the dialog box and
proceed as follows.

If drivers for other devices such as scanners are already installed, those device names
are displayed. Take particular care not to delete the wrong driver.

7 Display [Device Manager]. (W-82)

8 Delete [EOS Kiss REBEL 300D].

For Windows XP and Windows 2000 users:
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Uninstalling

● If [EOS Kiss REBEL 300D] is displayed when you click the plus symbol [+] to the left
of [Imaging devices] or [Other devices], select and right-click [EOS Kiss REBEL
300D] and select [Uninstall] from the menu that appears.

● When the confirmation message appears, click the [OK] button.
● Close [Device Manager], and click the [OK] button to close the [System Properties]

dialog box.
● If [EOS Kiss REBEL 300D] is displayed in both [Imaging devices] and [Other

devices], or is displayed more than once in [Other devices], delete all the
occurrences.

● When [EOS Kiss REBEL 300D] is not displayed in [Imaging devices] or [Other
devices], close the dialog box and proceed as follows.

For Windows Me and Windows 98 SE users:

● If [EOS Kiss REBEL 300D] is displayed when you click the plus symbol [+] to the left
of [Imaging devices] or [Other devices], select [EOS Kiss REBEL 300D] and click the
[Remove] button.

● When the confirmation message appears, click the [OK] button.
● Click the [OK] button to close the [System Properties] dialog box.
● If [EOS Kiss REBEL 300D] is displayed in both [Imaging devices] and [Other

devices], or is displayed more than once in [Other devices], delete all the
occurrences.

● When [EOS Kiss REBEL 300D] is not displayed in [Imaging devices] or [Other
devices], close the dialog box and proceed as follows.

9 Delete the driver settings files.
● The method for deleting the settings files differs depending on your operating system.

Refer to the information on the following pages to delete the settings files.
• Windows XP (W-87)
• Windows 2000 (W-88)
• Windows Me, Windows 98 SE (W-90)
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Uninstalling

Deleting the Driver Settings Files
Mistakenly deleting the wrong files can cause Windows to malfunction.
Check the file names carefully before deleting any files.

For Windows XP users:

1 Click the [Start] button and select [Control Panel] s [Appearance
and Themes] s [Folder Options].
\ The [Folder Options] dialog box appears.

2 Select the [View] tab.
\ The [View] tab sheet appears.

3 Select the [Show hidden files and folders] radio button in [Hidden
files and folders] and then deselect the [Hide extensions for
known file types] checkbox.
● If these settings are already

selected, simply proceed to the
next step.

4 Click the [OK] button to close the [Folder Options] dialog box.
\ Previously hidden folders and files now become visible.

5 Click the [Start] button and then [My Computer].

6 Double-click [C:] drive s the [WINDOWS] folder s the [Inf] folder
to open.
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Uninstalling

7 Search for files called [Oem*.inf] or [Oem*.pnf].
● Substitute a number such as 1 or 2 for the asterisk (*). Also, because [Oem*.inf] and

[Oem*.pnf] files come in pairs, substitute the same number for the asterisk in each
pair (e.g. Oem2.inf and Oem2.pnf).

● The [Inf] folder may contain multiple pairs of [Oem*] files.

8 Check the contents of the [Oem*.inf] files.
● Double-click an [Oem*.inf] file to display the file contents. Check that [; **** Canon

Camera Driver Setup File ****] appears on the first line.
● If there are multiple [Oem*.inf] files, repeat this procedure.
● Once you have identified the target file or files, make a note of the file names.

9 Delete the [Oem*.inf] and [Oem*.pnf] files you identified.

The [Inf] folder contains a large number of files. Deleting the wrong files could, at
worst, prevent Windows from starting up. When you delete files, check the file names
very carefully before proceeding.

For Windows 2000 users:

1 Click the [Start] button and select [Settings] s [Control Panel].

2 Double-click the [Folder Options] icon.
\ The [Folder Options] dialog box appears.

3 Select the [View] tab.
\ The [View] tab sheet appears.
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Uninstalling

5 Click the [OK] button to close the [Folder Options] dialog box.
\ Previously hidden folders and files now become visible.

6 In [My Computer] on the desktop, open [C:] s the [WINNT] folder
s the [Inf] folder.

7 Search for files called [Oem*.inf] or [Oem*.pnf].
● Substitute a number such as 1 or 2 for the asterisk (*). Also, because [Oem*.inf] and

[Oem*.pnf] files come in pairs, substitute the same number for the asterisk in each
pair (e.g. Oem2.inf and Oem2.pnf).

● The [Inf] folder may contain multiple pairs of [Oem*] files.

8 Check the contents of the [Oem*.inf] files.
● Double-click an [Oem*.inf] file to display the file contents. Check that [; **** Canon

Camera Driver Setup File ****] appears on the first line.
● If there are multiple [Oem*.inf] files, repeat this procedure.
● Once you have identified the target file or files, make a note of the file names.

9 Delete the [Oem*.inf] and [Oem*.pnf] files you identified.

4 Select the [Show hidden files and folders] radio button in [Hidden
files and folders] and then deselect the [Hide file extensions for
known file types] checkbox.
● If these settings are already

selected, simply proceed to the
next step.

The [Inf] folder contains a large number of files. Deleting the wrong files could, at
worst, prevent Windows from starting up. When you delete files, check the file names
very carefully before proceeding.
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For Windows Me and Windows 98 SE users:

1 Click the [Start] button and select [Settings] s [Control Panel].
Then double-click the [Folder Options] icon.
● Windows 98 SE users should click the [Start] button and select [Settings] s [Folder

Options].
\ The [Folder Options] dialog box appears.

2 Select the [View] tab.
\ The [View] tab sheet appears.

3 Select the [Show hidden files and folders] radio button in [Hidden
files and folders] and then deselect the [Hide file extensions for
known file types] checkbox.
● Windows 98 SE users should select the [Show all files] radio button in [Hidden files]

and then deselect the [Hide file extensions for known file types] checkbox.
● If these settings are already selected, simply proceed to the next step.

Windows Me Windows 98 SE

4 Click the [OK] button to close the [Folder Options] dialog box.
\ Previously hidden folders and files now become visible.

5 In [My Computer] on the desktop, double-click [C:] s the
[Windows] folder s the [INF] folder (the [inf] folder on Windows
98 SE) to open.
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Uninstalling

6 Delete [DRVDATA.BIN] and [DRVIDX.BIN].

7 Double-click the [Other] folder in the [INF] folder to open.

8 Delete the [Canon.IncCAP_E3KR.inf] file if it exists.

The [INF] folder contains a large number of files. Deleting the wrong files could, at
worst, prevent Windows from starting up. When you delete files, check the file names
very carefully before proceeding.

● “E3KR” is displayed in place of “XXX” in the file name.
● The [Canon.IncCAP_E3KR.inf] file may not exist depending on your computer system.
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Uninstalling Photoshop Elements 2.0
● Before beginning the software uninstallation, close all programs you are using and

disconnect the dedicated USB cable from your computer.
● Windows XP Professional or Windows 2000 users should log in using computer

Administrator privileges.

1 Click the [Start] button and then click [Control Panel] s [Add or
Remove Programs].
● In Windows versions other than Windows XP, click the [Start] button and then click

[Settings] s [Control Panel]. Then double-click the [Add/Remove Programs] icon in
the Control Panel.

\ The [Add or Remove Programs] or [Add/Remove Programs Properties] dialog box
appears.

2 Select [Adobe Photoshop Elements 2.0] from the list of software
applications displayed and click the [Remove] or [Add/Remove]
button.
● Users of Windows XP or Windows 2000 should check that the [Remove] button is

clicked.
\ The [Confirm file Deletion] dialog box appears.

3 Click the [Yes] button.
\ Photoshop Elements 2.0 is uninstalled.

When uninstallation ends, restart your computer.
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This chapter describes how to install the bundled software.

Installing the Software on
Your Computer



M-4

● Check that your Macintosh complies with the system requirements for the software (A-9) on
the SOLUTION DISK as you follow the installation procedure.

● For instructions for installing Photoshop Elements, refer to (M-6).

1 Start up your Macintosh.
● Close any programs that are running.

2 Insert the CD (EOS DIGITAL SOLUTION DISK).
\ The CD icon appears on the desktop.

3 Start up the Installer.
● Double-click the CD icon s the

[Mac OS X] folder s [Canon EOS
Digital Installer].

5 Check the software to be installed.
● Check that the checkboxes for the

software to be installed are
selected and then click the [Install]
button.

Installing the Software on Macintosh

OS X

OS 9

4Click [Digital Camera Software Installation].

● In OS 9, double-click the [Mac OS
9] folder in the CD window s
[Canon EOS Digital Installer].

\ The Installer panel appears.
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Installing the Software on Macintosh

6 Check the details of the User License Agreement.
● If you have checked the details and agree to the terms of the Agreement, click the

[Agree] button.

7 Check the folder in which the software will be installed.
● Check the install destination and

then click the [Choose] button.
\ Installation begins.
● The time required for the

installation varies depending on
your computer, but should take
approximately 2 to 4 minutes.

8 Complete the installation.
\ When [Installation has finished]

appears, installation is complete.
● Click the [OK] button to end the

installation.

● If the Installer panel appears, click
[Exit] to end the installation.

For OS 9 users :
● After clicking the [OK] button, the

restart dialog box appears. Then
click the [Yes] button to restart your
computer.
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● You are required to enter the serial number when installing Photoshop Elements 2.0. The
serial number is on a sticker attached to the Photoshop Elements 2.0 CD-ROM case.

● If you lose the serial number, you will not be able to install the software. To ensure that you
do not lose the serial number, carefully copy the serial number from the CD-ROM case or
transfer the serial number sticker into the field below.

1 Load the Adobe Photoshop Elements 2.0 CD-ROM into the CD-
ROM drive.
\ The [  Photoshop Elements 2.0] icon appears on the desktop.
\ In OS 9, The [  Photoshop® Elements 2.0] icon appears on the desktop.

2 Start up the Installer.
● Double-click the [Photoshop Elements 2.0] icon s the [Install Photoshop Elements]

icon.
\ The Photoshop Elements 2.0 installer panel appears.

3 Click the [Continue] button.

4 Proceed with the installation as directed by the on-screen
messages.

For detailed information on the installation procedure for Photoshop Elements 2.0
along with important information for installing on OS X, refer to the [How to Install
Read Me] file on the Photoshop Elements 2.0 CD-ROM.

Please Register Your Camera!
We recommend you take a moment to register your camera, in order to receive further product
information.
To proceed to the online User Registration page, simply click the [User Registration] button
from the [EOS DIGITAL SOLUTION DISK].
If there is no response when you click the [User Registration] button, start your Internet
browser program (such as Microsoft Internet Explorer or Netscape Communicator), then go to
the [Html] folder on the SOLUTION DISK and open the [regist.html] file inside the [English]
folder.

Installing Photoshop Elements 2.0
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This chapter explains how to set the communication mode, how to connect
the camera to your computer, and how to use a card reader (third-party
product).

Getting Ready to Work with
Images
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Setting the Communication Mode
To communicate with the camera using the software on the SOLUTION DISK, set the
camera’s communication mode to [Normal].

If you set the communication mode to [PTP], the SOLUTION DISK software
cannot communicate with the camera. When you are using the software, always
set the communication mode to [Normal].

1 Check that the camera is not connected to the computer and then
set the power switch to <ON>.

2 Set [Communication] in menu option <  > to [Normal].

3 Press the <MENU> button to switch the LCD monitor display off
and then set the power switch to <OFF>.

When setting the communication mode, always ensure that the camera is not
connected to the computer beforehand. Setting the communication mode while the
camera is connected to the computer will cause camera and software malfunctions.

About the PTP Setting
The PTP function is only available to OS X users. This function provides a simple means of
downloading JPEG images to your computer. To use this function, set [Communication] to
[PTP] in step 2 above.
● For more information on using the PTP function to download JPEG images, see

“Downloading JPEG Images Using the PTP Function in OS X (10.1 or later)” (M-12).
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USB port

Dedicated
USB cable

Dedicated
USB cable

DIGITAL terminal

Connecting the Camera to Your Computer
Connect the camera to your computer with the dedicated USB cable so that they can
communicate. You can connect the camera while your computer is running.

● When you connect the camera to your computer, be sure to follow the
procedure below.

● Never perform the following operations while the software installed from the
SOLUTION DISK is running after connecting the camera to the computer as a
communications error may occur.
• Set the camera’s power switch to <OFF>.
• Open the CF card slot cover.
• Disconnect the dedicated USB cable or remove the battery.
• Disconnect the DC coupler (optional) or unplug the AC adapter (optional) or

power cord.
Before you perform the operations above, be sure to exit the software being
used.

1 Plug the dedicated USB cable into the computer.
● Plug the cable into the USB port on

the computer.
● The location of the port differs

depending on your computer. Refer
to the User’s Manual for your
computer for details.

2 Plug the dedicated USB cable into your camera.
● Open the cover and plug the cable

connector into the <  >
terminal with the <  > (USB)
icon facing the front of the camera.

3 Set the camera’s power switch to <ON>.
\ The camera is now ready to communicate with your computer.
\ In OS 9, ImageBrowser starts up and the [ImageBrowser Automation wizard] dialog

box appears. ImageBrowser users should refer directly to “Chapter 5 Working with
Images in ImageBrowser”.

● To use an application other than ImageBrowser, quit ImageBrowser and start the
software you want to use.

● If you are using OS 9 and you want to set up the software so that ImageBrowser
does not start up, see “Disabling ImageBrowser Auto Start”. (M-62)
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Connecting the Camera to Your Computer

● Use only the dedicated USB cable to connect the camera to your computer.
● Push the plug firmly all the way into the socket. Loose connections can cause faults

or malfunctions.
● Connect the camera to the computer directly using the dedicated USB cable. The

camera and computer may not operate correctly if you connect them via a hub or if
you connect to multiple USB devices.

● The connection may not operate correctly if you are using other USB devices,
excluding USB mouse or keyboards, at the same time. If this occurs, disconnect the
other USB devices from the computer and try reconnecting the camera.

● Do not connect more than one camera to the same computer. The connections may
not operate correctly.

● While the camera and your computer are communicating, the camera’s LCD panel
may blink and, if you are using the LCD monitor, the image on the monitor may
flicker. This is not a malfunction.

● When unplugging the dedicated USB cable, be sure to grip the sides of the plug as
you pull it out.

● If you do not perform any operation while the camera and computer are connected,
a confirmation message appears on the computer screen asking whether you wish
to continue communicating with the camera for some computer systems. If you do
not perform any operation even after this message appears, the communication
with the camera is terminated. To re-establish the communication, press the shutter
button down halfway or set the camera’s power switch to <OFF> and then back to
<ON>.

● Do not put your computer to sleep while it is connected to the camera.
If you do put your computer to sleep while it is connected to the camera, never
disconnect the dedicated USB cable while your computer is still in sleep mode.
Always wake your computer up before disconnecting the camera. On some types of
computer, disconnecting the dedicated USB cable while your computer is in sleep
mode could prevent the computer from waking up correctly. Refer to the computer
User’s Manual for more information on Sleep mode.

When the camera is connected to a computer, you should use the DC Coupler Kit
(optional) so that you can continue using the camera regardless of battery level.

About Backing up (Copying) Images
You should back up (copy) the captured images on the hard disk of your
computer, etc. before working with EOS DIGITAL SOLUTION DISK.
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IMG_xxxx.JPG (JPEG images)

The folder that holds the image control files in the DCIM folder.

The folder created when DPOF settings are set. 
It holds the DPOF settings files.

CRW_xxxx.CRW (RAW images)

CRW_xxxx.THM (image used to show the camera index)

Inserting a CF Card into Your Card Reader
Users with a third-party card reader can download images directly from a CF card to the
computer.

1 Remove the CF card from the camera.

2 Load the card into the card reader.

3 Start your software and download the images.

CF Card Folder Structure and File Names

For information on connecting the card reader to your computer, refer to the User’s
Manual provided with the card reader.

The images on a CF card are placed in sub-folders named [xxxCANON], where the “xxx”
represents a number between 100 and 999, within the [DCIM] folder.

● The “xxxx” in file names represents four-digit numbers.
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Downloading JPEG Images Using the PTP Function in OS X (10.1 or later)
Users of OS X (version 10.1 or later) can use the PTP (Picture Transfer Protocol) function.
The PTP function allows you to download JPEG images stored on a CF card in the camera to
your computer without having to start the software provided on the SOLUTION DISK.

1 Set the camera’s communication mode to [PTP] (M-8).
● Set [Communication] in menu

option <  > to [PTP].
● Press the <MENU> button to clear

the LCD monitor display.
● When you have finished, switch the

camera off.

2 Connect the camera to the computer and set the camera’s power
switch to <ON> (M-9).
\ Image Capture or iPhoto starts up.
● You can specify which software

starts up in Image Capture.

3 Download the images as directed.
● Follow the instructions in the on-screen messages to download the JPEG images.

● To specify the software that will start up when the camera is connected to the
computer, start up Image Capture and select [Preferences] in the [Image Capture]
menu. In the [Image Capture Preferences] dialog box, select the application in the
[When a camera is connected, open] list box.

● Image Capture and iPhoto are software bundled with OS X. For detailed
information on using these applications, refer to the Help provided in the respective
application.
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M3
This chapter explains how to use File Viewer Utility to display and save
images stored on a CF card loaded in the camera, and also explains how
to perform image processing including processing RAW images and how
to transfer images to the retouching software.
● For more information on using File Viewer Utility, refer also to the sources listed

below.
ReadMe: Double-click the [Canon Utilities] folder s the [File Viewer Utility] folder

s [ReadMe].

Working with Images in
File Viewer Utility
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1 Connect the camera to your computer. (M-9)
● In OS 9, ImageBrowser starts up and the [ImageBrowser Automation wizard] dialog

box appears. Click the [Cancel] button and select [Quit] from the [File] menu to exit
ImageBrowser.

2 Double-click the [Canon File Viewer Utility] icon on the desktop to
start.
● You can also start File Viewer Utility by double-clicking the [Canon Utilities] folder s

the [File Viewer Utility] folder s the [File Viewer Utility] icon.
\ The File Viewer Utility main window appears.

Starting File Viewer Utility
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Starting File Viewer Utility

File Viewer Utility main window

* The above window shows all the information at once. In actual use, only the
information needed is displayed.

● To exit File Viewer Utility in OS X, select [Quit File Viewer Utility] from the [File Viewer
Utility] menu.

● To exit File Viewer Utility in OS 9, select [Exit] from the [File] menu.

Show/Hide Thumbnail Frames button
(M-23) Model-specific processing mode list box

(M-20)
Display Mode list box (M-21) Histogram

Shows the distribution
of the brightness of
an image.

Image information
display area (M-26)

Comment input box (M-26)

Status bar

Show the folder tree
(M-18)

Path display
Displays the connected camera,
drive on your computer and folder.

RGB value display
When you move the cursor over an
image, the coordinates of the
cursor position and its RGB values
(8-bit conversion) are shown here.

Display Size list box
(M-22)

Image transfer mode
list box (M-41)

Image display area
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Starting File Viewer Utility

Camera Settings button
(M-44)

Display AF point button (M-22)

Erase image button (M-25)

Select final image button (M-19)Enter Image Number input box (M-19)

Select first Image button (M-19)

Select Previous Image button (M-19)

Version button

Select Next Image button (M-19)

Preferences button (M-42)

Rotate left 90 degrees button (M-25)

Refresh button (M-23)

Transfer Images button (M-41)

Save File button (M-34, M-36, M-38)

IPTC information button
* This button is not supported for

images shot on this camera.

Select Image button (M-24)

Rotate right 90 degrees button (M-25)

Play sound button
* This button is not supported for

images shot on your camera.

protect button (M-24)

Remove protect button (M-24)

* The above window shows all the information at once. In actual use, only the
information needed is displayed.
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Starting File Viewer Utility

Digital Exposure Compensation button (M-28)

White Balance list box (M-29, M-30) Contrast list box (M-32)

Color tone list box (M-32)

Color Temp. input box (M-30)

Click White Balance button (M-31)

Color saturation list box (M-32)

* The above window shows all the information at once. In actual use, only the
information needed is displayed.

Sharpness list box (M-33)

Colorspace list box (M-33)
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Displaying Images
You can display images stored on a CF card in a camera or your computer.
RAW images are processed and displayed according to the processing parameters set on the
camera.
You can display images stored on a CF card via the dedicated USB cable while the CF card is
still in the camera. Or you can display images stored on a CF card using a third-party card
reader.
This section describes how to display images stored on a CF card in the camera.

Select a folder that contains images to be displayed.
● Click [s] to the left of the [EOS

DIGITAL REBEL] icon s [s] to the
left of the [DCIM] folder s the
[100CANON] folder in [Show the
folder tree].

\ The images saved in the selected
folder are displayed.

● Images that have been processed on your computer after being shot or images
whose file name has been changed may not be displayed properly.

● Deleting a folder erases all the images in that folder. Erased images cannot be
restored. Check carefully before deleting folder.

● The following images can be displayed in File Viewer Utility.
• JPEG images shot on a Canon digital camera
• RAW images shot on a Canon digital camera
• TIFF and JPEG images saved in File Viewer Utility (M-34)
* Images that cannot be displayed by File Viewer Utility appear as a question mark

[?].
● When you are displaying images stored on a computer or images on a CF card

using a third-party card reader, you can display the images in a folder by clicking
that folder in the same way.

● Images for which [Auto rotate display orientation] is set that were shot with the
camera held vertically are automatically displayed vertically.

● If the selected folder contains a large number of images, there may be a short delay
before the images appear.

● You can copy or move a folder in [Show the folder tree] by dragging and dropping it
onto another folder. On the menu that is displayed by clicking on the folder while
pressing the <control> key, you can create and delete the folder, or change the
folder name.

A number between 100 and 999 is displayed.

Your camera model is displayed.
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Selecting Images
Selecting Images with the Mouse

Position the mouse cursor over the image and click on it.
● To select multiple images, hold

down the <shift> key and click the
images.

● To select consecutive images, click
the first image and then hold down
the <option> + <shift> keys and
click the last image.

\ The frame around the selected
image changes color.

To select an image using the keyboard, use the arrow keys (↑ ← → ↓) to select an
image.

[Select final image] button
Selects the last thumbnail image
displayed.

[Select first Image] button
Selects the first thumbnail
image displayed.

[Select Previous Image] button
Selects the image before the
currently selected image.

[Enter Image Number] input box
Selects the image with the specified
number. You can enter a number
between 1 and 9999.
Enter the number and press the
<return> key.

[Select Next Image] button
Selects the next image.

Selecting Images from the Control Panel

Use the button or input a value.
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Selecting the Model-Specific Processing Mode
You can display the RAW image process tool bar to check and modify the processing used for
RAW images.
By selecting the model of the camera on which images were shot (model-specific processing
mode) in the [Model-specific processing mode] list box, you can check and/or modify the
processing used for RAW images shot on the selected camera.

Select a model-specific processing mode from the [Model-
specific processing mode] list box.

[Common Processing]
The RAW image process tool bar is hidden and the settings for RAW image processing
cannot be changed.

[EOS DIGITAL REBEL] / [EOS 300D DIGITAL]
The RAW image process tool bar is displayed. By selecting RAW images, you can check
and/or modify the image processing used. When a JPEG image is selected, however, the
RAW image process tool bar is grayed out and disabled.

When images shot on Canon cameras other than your camera are saved in the
selected folder or on a CF card in the connected camera, the model-specific
processing mode for the camera on which the images were shot is automatically
added to the [Model-specific processing mode] list box.

● See “Modifying RAW Image Processing Parameters” (M-27) for information on how
to change the RAW image processing parameters.

● If you select any other camera from [Model-specific processing mode] list box, the
RAW image process tool bar for the selected camera is displayed.

EOS DIGITAL REBEL / EOS 300D DIGITAL
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■ [Preview]
RAW images are displayed as single RAW images and JPEG images are displayed as single
JPEG images.

■ [JPEG Preview]
When you select a RAW image, simultaneously recorded JPEG image (Middle/Fine) in the
RAW image is displayed as a single image.
When you select a JPEG image, it is displayed as a single image just like the [Preview] mode.

● When you start File Viewer Utility, images are always shown in the [Thumbnail
display] mode.

● If you double-click on the thumbnail-displayed image, it is displayed in the [Preview]
mode.

● When you use your camera to shoot a RAW image, a JPEG image (Middle/Fine) is
recorded at the same time. When you select [JPEG Preview] for a RAW image, the
JPEG image (Middle/Fine) included in the RAW image is displayed.

Selecting the Image Display Mode

Display number
Numbers are assigned
sequentially to the
displayed images starting
with the first image. Recording format

The [RAW] symbol is displayed
for RAW images. No symbol is
shown for JPEG images.

Digital exposure
compensation value
(M-28)

File name or shooting date/time
The items selected in the [Image Lower Display Item] list
box in the [General Settings] tab sheet of the [Preferences]
dialog box (M-42) are displayed.

Protect mark (M-24)
This mark is displayed for
protected images.

You can select the mode and size used when images are displayed. You can also display the
AF point and choose whether the information display frame for thumbnail images is displayed.

Selecting the Display Mode

Click the [Display Mode] list box and select the mode.
\ The images are displayed in the

selected display mode.

■ [Thumbnail display]
This shows multiple images arranged in sequence. The information shown below is also
displayed for the images.
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Selecting the Image Display Mode

Checking the AF Point
The AF point used when the shot was taken can be displayed.

1 Select [Preview] or [JPEG Preview] from the [Display Mode] list
box. (M-21)

2 Click the [Display AF point] button.
\ The AF point used when the shot

was taken is displayed.
● Click the button again to hide the

AF point.

Selecting the Display Size

Click the [Display Size] list box and select the display size.
\ The image is displayed in the

selected display size.

In the [Preview] mode, the available image sizes are [Large] (100% – pixel-
equivalent), [Middle] (50%) and [Small] (25%).

For images taken with One-Shot AF, the active AF point is displayed. When the shot
was taken with automatic AF point selection, multiple active AF points might be
displayed.
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Selecting the Image Display Mode

Showing/Hiding the Information Display
Frame of Thumbnail Images

You can hide the information displayed on the frame of the thumbnail images (M-21) to display
more images in the image display area.

1 Select [Thumbnail display] from the [Display Mode] list box.
(M-21)

2 Click the [Show/Hide Thumbnail Frames] button.

\ The information display frame of the thumbnail image is hidden.
● Click the button again to display the information display frame of the thumbnail

image.

Updating Information on Main Window
If you alter the content of the folders currently displayed in [Show the folder tree] (by copying
or deleting images) while the images in a folder are displayed in the main window, the
information shown in the main window may no longer match the actual folder content. If this
occurs, update the main window display so that it matches the new folder information.

Click the [Refresh] button.
\ The information displayed in the

main window is updated.

Showing/Hiding Image Information
You can hide the histogram and image information display area to display more images in the
image display area.

Select the [Show] menu s [Information Area] s [Hide].
\ The histogram and image information display area are hidden.
● If you select the [Show] menu s [Information Area] s [Show], the histogram and

image information display area are displayed.
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Selecting Images by Condition
This feature allows you to select multiple images in a single operation using conditions.

Click the [Select Image] button and select the condition from the
menu that appears.
\ Only images that meet the

condition are selected.

Protecting Images
You can protect important images to prevent them from being accidentally erased.

Click the [protect] button.

\ The image is protected and the [  ] icon appears in the information display frame
for the image.

● Clicking the [Remove protect]
button unprotects the image and
clears the [  ] icon from the
information display frame for the
image.

● When multiple images are selected, all the selected images are protected.
● The [  ] is automatically displayed for images that were protected on the camera.
● Protection only prevents images from being erased. Other types of image

processing can still be performed for protected images.
● A range of operations is also available by selecting the image, pressing the

<control> key + mouse button and selecting an option from the menu that appears.

Working with Selected Images
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Working with Selected Images

Rotating Images
Use the procedure below to rotate a selected image by 90-degree increments left or right.

Rotate the image.
● To rotate the image right

(clockwise), click the [Rotate right
90 degrees] button.

● To rotate the image left
(counterclockwise), click the
[Rotate left 90 degrees] button.

\ The image rotates 90 degrees in
the selected direction.

● When multiple images are selected, all the selected images are rotated.
● Images for which [Auto rotate display orientation] is set that were shot with the

camera held vertically are automatically displayed vertically.
● If a rotated image is displayed in another application, the image may not appear

rotated.
● A range of operations is also available by selecting the image, pressing the

<control> key + mouse button and selecting an option from the menu that appears.

Erasing Images
Use the procedure below to erase unwanted images from a CF card or your computer.

1 Click the [Erase image] button.
\ An erase confirmation dialog box

appears.

2 Click the [Erase] button.
\ The image is erased.

● Erased images cannot be restored. Check carefully before erasing images.
● Protect important images (M-24) to prevent them from being accidentally erased.
● When multiple images are selected, all the selected images are to be erased. Take

particular care when you have just finished a task involving the selection of multiple
images.

A range of operations is also available by selecting the image, pressing the <control>
key + mouse button and selecting an option from the menu that appears.
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Working with Selected Images

Checking the Image Information and
Entering Comments

Shooting information is recorded when images are taken. You can check the shooting
information by selecting the image. Also, you can copy shooting information to paste it into
another application, and you can add a comment.

When the shot was taken using Adobe RGB
To transfer images shot in Adobe RGB color to retouching software for displaying, use
retouching software that supports Adobe RGB and specify [AdobeRGB] as the RGB
setting for display.

Printing Images
You can use File Viewer Utility to print images in index format.

1 Select images to be printed in index format (M-19).

2 Select [Print Index] in the [File] menu.
\ The Printer Setup dialog box appears.

3 Select the printer to be used, specify the print settings and print
images.

Image information display area
● Displays information such as the file name, camera model name and shooting

data. The number of items displayed differs depending on the camera settings.
● When you select multiple images, the information from the image selected last is

displayed.
● You can copy the information as text data and paste it into another application.

Comment input box
You can use this box to type in a comment up to 120 characters long.
Type in your comment and press the <return> key.
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Processing RAW Images
RAW images are processed based on the settings specified on the camera (including the
processing parameters and white balance) and then displayed on the computer.

● RAW images are processed in the following situations:
• When the display mode is switched from [Thumbnail display] to [Preview]
• When the processing parameters are changed while the image is displayed in [Preview] or
[Thumbnail display] mode

• When the image is converted to the TIFF or JPEG format and saved
• When the image is converted to the TIFF format and transferred to the designated
retouching software

* Linear processing and false color suppression can only be specified when an image is saved or is
transferred to retouching software (M-43).

● Approximate processing times

• The processing times given here are only approximations. Actual processing times
vary widely depending on the images and the computer system.

• Processing times are based on Canon testing standards.
(OS: OS X (10.2); CPU: Power PC G4 700 MHz; RAM: 256 MB)

• The processing time in the retouching software includes starting up time of the retouching
software.

Modifying RAW Image Processing
Parameters

File Viewer Utility allows you to modify the image processing parameters until the displayed
RAW image is optimal for its intended purpose. You can also specify additional processing
parameters not available on the camera, such as digital exposure compensation and white
balance adjustment using the Click White Balance function.

● This processing applies the specified parameters virtually and does not affect the original
RAW images in any way. Consequently, you can redo the processing as often as you like
with different parameters and then reset the modified parameters to the settings used when
the shot was taken.

When the display mode is
switched from [Thumbnail display]
to [Preview]

Image converted to TIFF format
and transferred to the specified
retouching software

When the display mode is
switched from [Thumbnail display]
to [Preview]

Image converted to TIFF format
and transferred to the specified
retouching software

Processing TimeProcessing Parameters

When RAW images saved on
a CF card in the camera are
processed

When RAW images saved on
the computer’s hard disk are
processed

Approx. 55 sec.

Approx. 90 sec.

Approx. 24 sec.

Approx. 63 sec.
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Processing RAW Images

2 Compensate the image brightness.
● Position the mouse cursor over the

slider and drag it left or right to
adjust the amount of
compensation.

● When you click the [Preview]
button, the image brightness
changes to reflect the value to
which the slider was dragged.

3 Click the [OK] button.
\ The corrected value is applied to the image and the [Digital Exposure Compensation]

dialog box closes.
\ The corrected value is displayed with the corrected image.

Compensating the Brightness (Digital Exposure Compensation)
You can compensate the brightness of an image in the range of +/–2 stops in 0.1-stop
increments.

1 Click the [Digital Exposure Compensation] button.
\ The [Digital Exposure

Compensation] dialog box appears.

1 Select [EOS DIGITAL REBEL] from the [Model-specific
processing mode] list box. (M-20)

2 Select the RAW image to be processed. (M-19)
● See the following information on how to modify the processing parameters.

3 Save (M-34) and transfer (M-40) the image.
● You can specify the bit depth used when the image is saved and transferred in the

[RAW Image Processing settings] tab sheet in the [Preferences] dialog box (M-43).

Processing parameters modified in File Viewer Utility are all cancelled and the
parameters used when the shot was taken are restored when you exit File Viewer
Utility. Consequently, you should convert images with modified parameters to the TIFF
or JPEG format and save them, or transfer them to the retouching software and save
them.

If you selected multiple images, the specified processing parameters are applied to all
the selected RAW images.
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Processing RAW Images

Adjusting the White Balance
You can adjust the white balance in your RAW images.
You can adjust the white balance by selecting a setting in the [White Balance] list box. You can
also make fine adjustments to the white balance by using the Click white balance function,
which allows you to adjust the white balance by selecting a white area in the image.

Select the White Balance

Select the desired setting from the [White Balance] list box.
● The table below shows the 9

available white balance settings.
\ The selected setting is applied to

the image.

White Balance

Shot Settings

Auto

Daylight

Shade

Cloudy

Tungsten

Fluorescent

Flash

Color Temp

Details

To apply the white balance setting used when the
shot was taken.

File Viewer Utility automatically sets the white
balance.

For sunny daylight outdoors.

For shaded areas outdoors.

For cloudy or hazy days and during sunset.

For tungsten (light bulb) light.

For fluorescent light.

When flash is used.

You can manually set color temperature for 2800
to 10000K (in 100K increments). (M-30)

Color temp./K (Kelvin)

–

Approx. 3000 to 7000

Approx. 5200

Approx. 7000

Approx. 6000

Approx. 3200

Approx. 4000

Approx. 6000

Approx. 2800 to 10000
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Processing RAW Images

Setting the Color Temperature
You can set the color temperature to a value between 2800K and 10000K (in 100K
increments).

1 Select [Color Temp] from the [White Balance] list box.

2 Enter a color temperature.
● Enter the color temperature in the

[Color Temp.] input box.
● You can enter values between

2800K and 10000K (in 100K
increments).

3 Press the <return> key.
\ The specified value is applied to the image.
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Processing RAW Images

Click White Balance Function
This function allows you to automatically adjust the white balance simply by clicking a point in
a white part of the image.

1 Click the [Click White Balance] button.
\ When you move the cursor over

the image, it changes to the shape
of an eyedropper.

2 Click in a white area in the image.

\ The white balance is adjusted so that the area clicked appears white and the result is
displayed.

● To adjust the white balance using a different location, click the [Click White Balance]
button again.

When you use Click White Balance Function, [White Point] is displayed in the [White
Balance] list box.
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Processing RAW Images

Adjusting the Color in Images
Use the procedures below to adjust the color parameters (contrast, color saturation and color
tone) in images. You can adjust the color by selecting settings from the respective list boxes.

Adjusting the Contrast

Select the desired setting from the [Contrast] list box.
\ The selected setting is applied to

the image.

Adjusting the Color Saturation

Select the desired setting from the [Color saturation] list box.
\ The selected setting is applied to

the image.

Adjusting the Color Tone

Select the desired setting from the [Color tone] list box.
\ The selected setting is applied to

the image.
● [–2] strongly adjusts the colors so

that skin tones appear redder while
[–1] makes the same adjustment
less strongly.
[0] applies the standard color
matching adjustment.
[+2] strongly adjusts the colors so
that skin tones appear yellower
while [+1] makes the same
adjustment less strongly.
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Processing RAW Images

Adjusting the Sharpness
You can adjust the edge sharpness of the image.

Select the desired level from the [Sharpness] list box.
\ The selected level is applied to the

image.

Specifying the Color Space
Use the procedure below to change the color space for the image.

Select the desired setting from the [Colorspace] list box.
\ The selected setting is applied to

the image.

Copying the Processing Parameters for RAW Images
This process allows you to quickly and easily apply the processing parameters used for one RAW image
(such as the digital exposure compensation and white balance adjustment settings) to other images.

1 Hold down the <control> key and click a RAW image that has
been processed and select [Copy Current Conditions] from the
menu that appears.

2 Hold down the <control> key and click the RAW image to which
you want to apply the parameters and select [Paste Current
Conditions] from the menu that appears.
\ The copied processing parameters are applied to the selected RAW image.
● You can apply the same processing parameters to multiple RAW images by copying

the processing parameters, selecting the RAW images (M-19) hold down the
<control> key and click one of the selected images and then selecting [Paste Current
Conditions] from the menu that appears.

When transferring images that were set to [AdobeRGB] to retouching software, use retouching
software that supports Adobe RGB and specify [AdobeRGB] as the RGB setting for display.

When you exit File Viewer Utility, all the modified processing parameters are
cancelled and the parameters used when the shot was taken are restored. (M-27)
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Saving Images
This section explains how to save captured images stored on a CF card onto your computer,
how to extract JPEG images from RAW images using a simple procedure and then save the
JPEG images onto your computer, and how to save multiple images as an index file on your
computer.

Saving Images from the Camera to Your Computer
You should save the images you have shot on your computer.

1 Select images to be saved. (M-19)

2 Click the [Save File] button and select [Convert and save in file]
from the menu that appears.
\ The [Save File] dialog box appears.

3 Specify the desired settings and click the [OK] button.
\ The images are saved in the selected folder.

1

3

2

10

65

9

7

11

12

4

8
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Saving Images

Conversion Format

Do not convert

Exif-JPEG

Exif-TIFF(8bit/ch)

TIFF(16bit/ch)

File Extension

_.CRW

_RJ.JPG

_RT8.TIF

_RT16.TIF

To use linear processing, specify linear processing in the [Preferences] dialog box (M-
43) and select [TIFF(16bit/ch)] when you save the image. Even when linear
processing is specified, linear processing cannot be applied to images saved in [Exif-
TIFF(8bit/ch)] format.

6 You can specify the [Compression Ratio] (image quality) when you select [Exif-JPEG] from
the [Convert from RAW to Other Format] list box. You can select from 4 compression
ratios-[4] to [1 (High Compression Ratio)]. The higher the value, the higher the quality of
the JPEG image.

7 Click this checkbox when you want to save the image without changing the name.
8 This is text inserted before the file number for sorting. You can enter up to 12 characters.

When you enter text, an example of the file name appears in the [Example] field below the
text box.

9 You can specify up to 9 digits for the file number.
10 Specifies the first file number.
11 Images shot on your camera do not support this function.
12 Images shot on your camera do not support this function.

A range of operations is also available by selecting the image, pressing the <control>
key + mouse button and selecting an option from the menu that appears.

1 The converted image is saved as a new image in the same folder as the selected image.
You cannot use this option when the images selected are saved on a CF card in the
camera. This option is only available when the selected images are saved on your
computer or on a CF card in a card reader.

2 Use this button when you want to specify the folder in which the image will be saved.
3 When the [Save in following specified folder] radio button is selected, this button specifies

the folder in which the image will be saved.
4 Shows the folder in which the image will be saved.
5 Select this option when the images to be saved include RAW images.

Select [Do not convert], [Exif-JPEG], [Exif-TIFF(8bit/ch)] or [TIFF(16bit/ch)].
The file extensions used for the saved files are shown below.
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Saving Images

1

7

8

2

3

5

4

6

Extracting JPEG Images from RAW Images
When a RAW image is shot on your camera, a JPEG image (Middle/Fine) is recorded at the
same time. You can save the JPEG image (Middle/Fine) included with the RAW image to your
computer by selecting the RAW image shot on your camera and extracting the JPEG image.

1 Select the RAW image from which a JPEG image is to be
extracted. (M-19)

2 Click the [Save File] button and select [Extract & Save JPEG]
from the menu that appears.
\ The [Extract & Save JPEG] dialog

box appears.

3 Specify the desired settings and click the [OK] button.
\ The JPEG image is saved in the selected folder.
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Saving Images

1 The converted image is saved as a new image in the same folder as the selected image.
You cannot use this option when the images selected are saved on a CF card in the
camera. This option is only available when the selected images are saved on your
computer or on a CF card in a card reader.

2 Use this button when you want to specify the folder in which the image will be saved.

3 When the [Save in following specified folder] radio button is selected, this button specifies
the folder in which the image will be saved.

4 Shows the folder in which the image will be saved.

5 Click this checkbox when you want to save the RAW image without changing the name.

6 This is text inserted before the file number for sorting. You can enter up to 12 characters.
When you enter text, an example of the file name appears in the [Example] field below the
text box.

7 You can specify up to 9 digits for the file number.

8 Specifies the first file number.

A range of operations is also available by selecting the image, pressing the <control>
key + mouse button and selecting an option from the menu that appears.
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Saving Images

Saving Images as an Index File
This function combines multiple images into an index image and saves the index on your
computer as a single JPEG file.

1 Select images to be saved as an index. (M-19)

2 Click the [Save File] button and select [Save Index] from the
menu that appears.
\ The [Index sheet options] dialog

box appears.

1

2

3

4

5 6

3 Enter the settings and click the [OK] button.
\ The [Save File] dialog box appears.

1 Enter the width of the index sheet to be created. You can specify values between 4 and 11
inch.

2 Enter the height of the index sheet to be created. You can specify values between 4 and
11 inch.

3 Enter the resolution of the index images. You can specify values between 50 and 300
pixels per inch.

4 Indicates the projected image file size based on the specified width, height and resolution.
5 Cancels the index sheet options settings.
6 The settings are applied and the [Index sheet options] dialog box closes.
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Saving Images

1
2

3
4

5

6

7

4 Specify the desired settings and click the [OK] button.
\ The images are saved as an index in the selected folder.

1 The converted image is saved as a new image in the same folder as the selected image.
You cannot use this option when the images selected are saved on a CF card in the
camera. This option is only available when the selected images are saved on your
computer or on a CF card in a card reader.

2 Use this button when you want to specify the folder in which the image will be saved.
3 When the [Save in following specified folder] radio button is selected, this button specifies

the folder in which the image will be saved.
4 Shows the folder in which the image will be saved.
5 This is text inserted before the file number for sorting. You can enter up to 12 characters.

When you enter text, an example of the file name appears in the [Example] field below the
text box.

6 You can specify up to 9 digits for the file number.
7 Specifies the first file number.

A range of operations is also available by selecting the image, pressing the <control>
key + mouse button and selecting an option from the menu that appears.
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5 Select the folder to be used for saving the transferred images and
then click the [Choose] button.
\ The folder is specified and then the [General Settings] tab sheet appears.

6 Click the [OK] button.
\ The settings are applied and the [Preferences] dialog box closes to end the

procedure.

Transferring Images to Retouching Software
This section describes how to transfer images displayed in File Viewer Utility to the retouching
software and also describes how to make settings for image transfer.

● In order to transfer images, you will need the retouching software such as
Adobe Photoshop Elements 2.0.

● Be sure to make the image transfer settings before transferring images.

Specifying the Image Transfer Settings
Before transferring images, it is necessary to specify the retouching software to which images
will be transferred and the folder for saving the transferred images. The descriptions given
here show how to transfer images to Photoshop Elements 2.0, as an example.

1 Display the [General Settings] tab sheet in the [Preferences]
dialog box. (M-42)

2 Click the [Browse] button of [Image Transfer Application].
\ The [Select application] dialog box

appears.

3 Select [  Photoshop Elements 2.0] and then click the [Choose]
button.
● On the drive where Photoshop Elements 2.0 is installed, open the [Photoshop

Elements 2.0] folder and select [Photoshop Elements 2.0].
\ Photoshop Elements 2.0 is specified as the retouching software to which images will

be transferred and then the [General Settings] tab sheet appears.

4 Click the [Browse] button of [Image transfer folder].
\ The [Select transfer folder] dialog

box appears.

It is not necessary to specify the retouching software to which the images will be
transferred and the folder for saving the transferred image every time unless you wish
to change those settings.
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Transferring Images to Retouching Software

Transferring Images
This section describes how to transfer the images displayed in File Viewer Utility to the
retouching software. Although the descriptions given here show how to transfer images to
Photoshop Elements 2.0, as an example, you can also transfer images by following the same
procedure even if you specify any other retouching software in “Specifying the Image Transfer
Settings” (M-40).

1 Select images to be transferred. (M-19)

2 Select the transfer mode from the [Image transfer mode] list box.
● There are 2 available transfer

modes.
[Single-Frame Transfer]:
The selected images are
transferred as an individual image.
[Transfer as Index Image]:
Thumbnails are created for the
selected images and transferred as
an index sheet (JPEG format).

3 Click the [Transfer Images] button.
\ If you selected [Transfer as Index

Image], the [Index sheet options]
dialog box appears.

\ If you selected [Single-Frame
Transfer], the image will be
transferred.

● For information on how to make
settings in the [Index sheet options]
dialog box, refer to step 3 in
“Saving Images as an Index File”
(M-38).

4 Enter the settings and click the [OK] button.
\ Photoshop Elements 2.0 starts up and displays the transferred image.
\ The transferred image is saved in the image transfer folder that you have set.
\ RAW images are processed and then converted to TIFF format before being

transferred.

A range of operations is also available by selecting the image, pressing the <control>
key + mouse button and selecting an option from the menu that appears.
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Specifying the Preferences
You can use the procedure below to specify the settings for image transfer and the processing
parameters used for RAW images when images are transferred and saved.

1 Click the [Preferences] button.
\ The [Preferences] dialog box

appears.

2 Select the [General Settings] tab or the [RAW Image Processing
settings] tab.
\ The selected tab sheet appears.

3 Specify the desired settings and click the [OK] button.
\ The settings are applied and the [Preferences] dialog box closes to end the

procedure.

● You can specify the settings shown below in the [General Settings] tab sheet.

1 When you click the [Transfer Images] button (M-41), the retouching software to which the
image will be transferred is specified. (M-40)

2 Specify the folder for saving the image to be transferred to the retouching software.
(M-40)

3 Specify the information to be displayed below images. Select [File Name] or [Shooting
Date/Time] in the list box.

4 Sets the resolution used when images are transferred to a retouching software such as
Photoshop Elements 2.0. You can specify values between 10 and 2000 pixels per inch.

1

2

3

4
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Specifying the Preferences

9

7

6

8

12

● You can specify the settings shown below in the [RAW Image Processing
settings] tab sheet.
The settings described here are those shown when [EOS DIGITAL REBEL] / [EOS 300D
DIGITAL] is selected in the [Model Name] list box.

5 Select [EOS DIGITAL REBEL] / [EOS 300D DIGITAL].
* When images shot on a Canon camera are saved in the selected folder or on a CF card

in the connected camera, the camera model is automatically added to the list of camera
models.

6 If you select this option, image adjustment is not performed. Select this option when you
want to use your own retouching software to make fine adjustments to the saturation.

7 Clicking this checkbox neutralizes false colors.
8 When you click this checkbox, a 16% reduced image is shown in the [Preview] mode.
9 Select [8 bits per color channel] or [16 bits per color channel] as the bit rate.

● The buttons listed below are displayed in each of the tab sheets. They
function in the same way in each sheet.

10 Restores the default settings for all the parameters in the currently displayed tab sheet.
11 Cancels all the settings, restores the parameters to their original values and ends the

procedure.
12 Applies the specified parameters, closes the [Preferences] dialog box and ends the

procedure.

5

10

11

When you select any other camera in the [Model Name] list box, the available settings
for the respective camera model are displayed.

EOS DIGITAL REBEL /
EOS 300D DIGITAL
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Specifying the Camera Settings
Use the procedure described here to apply the owner name and date and time settings to the
camera. The owner name, and date and time that were applied on the camera are recorded
with the images.
You can also format (initialize) CF cards and check the camera properties data and the status
of the battery and the CF card.

Display the [Camera Settings] dialog box.
● To display this dialog box from File

Viewer Utility, click the [Camera
Settings] button in the main
window.

● To display this dialog box from
RemoteCapture, select [Camera
Setting] from the [File] menu.

● To display this dialog box from
ImageBrowser, select the [Camera
Settings] in the menu that appears
by clicking the [SETUP OPTIONS]
button in the Camera window, or
select the [Canon Camera] menu
s [Settings] s [Camera Settings].
See Chapter 5, ”Working with
Images in ImageBrowser”, for
information on how to display the
Camera window.

\ The [Camera Settings] dialog box appears.
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Specifying the Camera Settings

Basic Settings tab sheet

This box shows the camera
model, body ID (serial
number) and firmware
version.

These fields set the camera
owner and the date and time.
You can enter up to 31
characters in [Owner’s Name].

This box shows whether a CF
card is loaded in the camera
along with the available space
on the card and its total
capacity. You can also format
a CF card from this box.

Cancels all the settings, restores
the parameters to their original
values and ends the procedure.

Applies the settings.

Formatting (initializing) a CF card erases all the data on the card. Because formatting
also erases protected images, you should check the data recorded on the card
carefully before proceeding.

The battery level of the camera is
indicated by [OK] or [LOW].
When the camera is connected to
a household power source using
the DC Coupler Kit (optional),
[AC] is displayed.

Applies the specified settings,
closes the [Camera Settings] dialog
box and ends the procedure.
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Specifying the Camera Settings

Setting the Owner’s Name, Date and Time

1 Enter the Owner’s Name.
● Type in the name from your keyboard. You can enter up to 31 characters.

2 Set the Date and Time.
● Use the mouse to select Date/Time and then use the [▲] and [▼] buttons ([c] and

[d] buttons in OS 9) to set the date and time, or enter the desired date and time from
the keyboard. Alternatively, you can import the Date and Time data from your
computer by selecting the [from Mac] checkbox.

3 Click the [Apply] button.
\ The owner’s name, date and time settings are applied to the camera.
● Once you click the [Apply] button, the settings remain effective until you reset the

owner’s name, date or time.
● Clicking the [OK] button applies the specified settings, closes the [Camera Settings]

dialog box and ends the procedure.
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This chapter describes the operations using the RemoteCapture software,
such as remote shooting, timer shooting and interval timer shooting.
● For more information on using RemoteCapture, refer also to the sources listed

below.
ReadMe: Double-click the [Canon Utilities] folder s the [RemoteCapture] folder

s [ReadMe].
Help: Displayed by selecting [RemoteCapture Help] in the [Help] menu.

Operating the Camera from
Your Computer

4



M-48

Starting RemoteCapture

1 Connect the camera to your computer. (M-9)
● In OS 9, ImageBrowser starts up and the [ImageBrowser Automation wizard] dialog

box appears. Click the [Cancel] button and select [Quit] from the [File] menu to exit
ImageBrowser.

2 Double-click the [Canon Utilities] folder s the [RemoteCapture]
folder s [RemoteCapture] to start.
\ The [Connect to camera?] dialog box appears.

3 Click the [Connect] button.
● When the [Communication

Settings] dialog box appears,
select [USB Port] from the [Port] list
box, select your camera from the
[Detected Camera] list box and
then click the [Set] button.

\ The Shooting window and Save
window appear.

Shots to Go
Displays the number of frames that
can be saved on your computer or
on the CF card in the camera.

Release button
Takes a shot. The image is
automatically saved on your
computer. Even when you
press the shutter button on
the camera, the image is
saved on your computer.

Shooting window

Detail setting button
Displays the Detailed Settings
window below the Shooting window
allowing you to make various
settings. Click the button again to
close the Detailed Settings window.

Size/Quality list box
Allows you to select the
image recording quality.
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Starting RemoteCapture

Image display area
Displays the image selected
in the thumbnail view.

Histogram
Shows the distribution of
the brightness of an
image.

Image Information
Allows you to check the
image information details.

Comment input box
Use this field to type in a comment for the image.

Thumbnail view
Displays thumbnail
images of the shots
taken.

Delete button
Deletes the image selected in thumbnail view.
Deleted images are completely removed from
your computer. Check images carefully before
deleting them.

View button
Displays the image selected
in thumbnail view enlarged
in a separate window.

Disconnect button
Cuts the connection to the
camera.

Save window

The [RAW] symbol is
displayed for RAW images.
No symbol is shown for
JPEG images.

* The above window shows all the information at once. In actual use, only the
information needed is displayed.

● To exit RemoteCapture in OS X, select [Quit RemoteCapture] from the
[RemoteCapture] menu.

● To exit RemoteCapture in OS 9, click the [Disconnect] button and select [Exit] from
the [File] menu.

● You can specify the camera settings (M-44) by selecting [Camera Setting] in the [File]
menu.
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4 Click the [Release] button.
\ The captured image is saved to your computer and displayed on the screen.
● To enlarge the image for checking, select the image and click the [View] button.
● To delete the image, select the image and click the [Delete] button.

Using RemoteCapture
You can control the camera from your computer and take single-frame shots, timer shots and
interval timer shots. The images are automatically saved on your computer.
Shots taken with RemoteCapture and saved on your computer can be displayed and
processed in File Viewer Utility in the same way as images shot with the camera.
Refer to the Help file for more information on using RemoteCapture.

Before you use RemoteCapture, be sure to confirm that the camera is ready for
shooting. If the camera is not ready for shooting (the lens is not attached, etc.),
you cannot perform the operation as shown below.

Taking Shots from Your Computer

1 Set the camera up ready to shoot.

2 Make various settings.
● For information on how to set the size and image quality, refer to “Shooting window”

(M-48).
● See “Default Settings” (M-53) for information on how to save images.

3 Take a test shot.
● Click [ ] (the Detail setting button) in the Shooting window and select the [Angle

adjustment] tab in the displayed Detailed Settings window, and then click the [Test
Shot] button.

\ The test-shot image is displayed in the test-shot image display area.

Test-shot image
display area
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Using RemoteCapture

To rotate a downloaded image, select the image and then select [Rotate Saved Image
90 degree Right] or [Rotate Saved Image 90 degree Left] in the [Edit] menu.

Timer Shooting
Use this function to specify the timer delay. Timer shooting shots are then taken after the
specified number of seconds.

1 Select [Timer Shooting] in the [File] menu.
\ The [Timer Shooting] dialog box appears.

2 Enter the timer setting (in seconds) and click the [Start] button.
● You can set a value between 2 and 30 seconds in 1-second increments.
\ Timer shooting shots are taken after the specified number of seconds.

● With the auto focusing, if the camera cannot focus, you cannot take shots.
If you cannot take shots with the auto focusing, focus manually and then take a
shot.

● The test-shot images taken with the camera held vertically are displayed in the
normal (horizontal) orientation in the test-shot image display area.

Approximate Transfer Times

• The transfer times given here are only approximations. Actual transfer times vary
widely depending on the images and the computer system.

• Transfer times are based on Canon testing standards.
(Time until the RAW image appears in the Save window when the [Release] button is
pressed in the Shooting window and [Computer only] is specified using the following: OS:
OS X (10.2); CPU: Power PC G4 700 MHz; RAM: 256 MB)

• The times for images shot in JPEG format will be shorter than those shown above.

Transfer Time Approx. 59 sec.
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Using RemoteCapture

Interval Timer Shooting
This function allows you to specify the interval between shots and the number of shots.

1 Select [Interval Timer Shooting] in the [File] menu.
\ The Interval Timer Shooting warnings dialog box appears.

2 Check the information in the warnings and then click the [Yes]
button.
\ The [Interval Timer Shooting] dialog box appears.

3 Enter the shooting interval and the total number of shots. Then
click the [Start] button.
● You can set a shooting interval between 5 seconds and 60 minutes in 1-second increments.
● You can set up to a maximum of 9999 shots.
\ Interval timer shooting is performed using the specified interval between shots and

the specified number of shots.

On some types of computers, if you set a short interval between shots and there is insufficient
time to download and save the images, it may not be possible to take shots at the specified
interval. If this occurs, set a longer interval between shots and take the shots again.

Depending on the available capacity on your computer’s hard disk, the maximum number of
available shots that can be set may be less than 9999. You can check the number of shots that
can be set by referring to the number of available shots shown in the Shooting window. (M-48)

Checking Shooting Settings
You can confirm the camera settings used when images are taken.

Select [Display Shooting Modes] in the [File] menu.
\ The [Shooting Settings] dialog box appears, displaying the camera settings used

when images are taken.
● Clicking the [OK] button closes the [Shooting Settings] dialog box.

Printing Images
You can print images. All the images shown in the thumbnail view are printed in index format.
The time of shooting and the file names are printed with the images.

1 Select [Print Index] in the [File] menu.
\ The Printer Setup dialog box appears.

2 Select the printer to be used, specify the print settings and print
images.
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This section describes how to make various settings for using RemoteCapture. In the settings,
you can specify Default Settings to save images on your computer, and you can also specify
Detailed Settings to make shooting settings from your computer remotely.

Default Settings
Use the procedure below to select the folder in which images will be saved and to specify the
file names.

1 Select [Preferences] from the [RemoteCapture] menu.
● If you are using OS 9, select [Preferences] from the [File] menu.
\ The [Preferences] dialog box appears.

2 Specify the desired settings and click the [OK] button.
\ The settings are saved and the [Preferences] dialog box closes to end the procedure.

Setting RemoteCapture

3

4

6

1

2

5

8
7
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Setting RemoteCapture

1 You can use this option to take shots when there is no CF card in the camera or when the
CF card is full.

2 Saves captured images both on your computer and on the CF card in the camera.
3 Use this field to enter a file name when saving a captured image.

* The file name can consist of up to 16 characters.
4 Sets the number of digits in the sequence number that follows the file name and the

starting number used.
* If you enter [Capture] into [File Prefix] field, [5] into [Number of Digits], and [1] into [Start],

sequential file names will be assigned automatically beginning with [Capture_00001.JPG]
or [Capture_00001.CRW].

5 Displays the directory path for the folder in which files are saved.
6 Use this to select the folder on which files are saved.
7 Cancels all the specified settings, restores the previous settings and ends the procedure.
8 Applies the specified settings, closes the [Preferences] dialog box and ends the

procedure.

You can set the Hotkey for shutter release by selecting the [Release Hotkey] tab.
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Setting RemoteCapture

1

32

4

Detailed Settings
You can set shooting settings, such as White Balance and Exposure Compensation, from your
computer remotely.

● Before you make detailed settings, be sure to confirm that the camera is
ready for shooting. If the camera is not ready for shooting (the lens is not
attached, etc.), you cannot make some of the settings.

● The shooting settings cannot be specified if the camera’s shooting mode is
set to the Basic zone. Set the camera’s shooting mode to the Creative zone.

1 Display the Detailed Settings window.
● Click [   ] (the Detail setting button) in the Shooting window.

2 Click the [Shooting modes adjustment] tab.
\ The [Shooting modes adjustment] tab sheet appears.

3 Specify the settings and then close the Detailed Settings window.
● Click [ ] (the Hide detail setting button) in the Shooting window.

* The above window shows all the information at once. In actual use, only the
information needed is displayed.
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Setting RemoteCapture

1 Allows you to specify White Balance.
2 Allows you to perform Exposure Compensation.

(Enabled only when Program AE, Shutter-priority AE, Aperture-priority AE or Automatic
Depth-priority AE is selected as the shooting mode on the camera.)

3 Allows you to specify ISO Speed.
4 Allows you to specify the Av (aperture value) and Tv (shutter speed) settings.

(The specifiable settings are only displayed when Shutter-priority AE, Aperture-priority AE
or Manual Exposure is selected as the shooting mode on the camera.)
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This chapter explains how to use ImageBrowser to perform a range of
operations from downloading the camera’s images to printing them.
● For more information on using ImageBrowser, refer also to the sources listed

below.
ReadMe: Double-click the [Canon Utilities] folder s the

[ImageBrowser] folder s [ReadMe].
Help: Displayed by selecting [ImageBrowser Help] in the [Help]

menu.
Software User Guide: View by downloading from the Canon website. See

“ZoomBrowser EX/ImageBrowser Software User Guide”
(A-7) for details.

Working with Images in
ImageBrowser

5
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Starting ImageBrowser

1 Connect the camera to your computer. (M-9)
\ In OS 9, ImageBrowser starts up and the [ImageBrowser Automation wizard] dialog

box appears.
● To cancel [ImageBrowser Automation wizard], click the [Cancel] button to close the

[ImageBrowser Automation wizard] dialog box.
\ To use [ImageBrowser Automation wizard], proceed to “Automatic Startup from the

Auto Run Dialog Box”. (M-60)

Folders area
The [RAW] symbol is
displayed for RAW images.

Browser area
Displays the images in the folder
selected in the Folders area.

Click here to connect the camera
and display the Camera window.

Click here to select all the images.

Click here to delete images.

Click here to print images.

Click here to display images.

Click here to magnify or reduce images.

OS 9OS X

2 Double-click the [Canon ImageBrowser] icon.
● Double-click the [Canon

ImageBrowser] icon on the desktop
or the [Canon Utilities] folder saved
in the folder specified during
installation s the [ImageBrowser]
folder s the [ImageBrowser] icon.

\ When you start ImageBrowser, the Browser window appears.

Browser Window



M-59

W
or

ki
ng

 w
ith

 Im
ag

es
 in

 Im
ag

eB
ro

w
se

r

5

M

Starting ImageBrowser

Saves images from the computer
onto the CF card in the camera.

An image of the camera or CF
card will be displayed here.

Sets various camera
settings. See
“Specifying the
Camera Settings”
(M-44) for information
on how to set.

Downloads the selected images onto the computer.

The [RAW] symbol is displayed for RAW images.
No symbol is shown for JPEG images.

Lets you edit
the slide show
and DPOF print
specifications.

Rotates images.

Click here to print images.

Reconnects the camera
to your computer.

Allows you to select all the images
displayed in the Camera window
at a time.

Click here to delete images.

3 Click the [CANON CAMERA] button.
\ The Camera window appears and

the images stored on the CF card
in the camera are displayed.

● When the [Communication Settings] dialog box appears, select [USB Port] from the
[Port] list box and select the connected camera from the [Detected Camera] list
box. Then click the [Set] button.

● You can also open the Camera window by clicking the [Canon Camera] icon in the
Folders area.

Camera window

● To exit ImageBrowser in OS X, select [Quit ImageBrowser] from the [ImageBrowser] menu.
● To exit ImageBrowser in OS 9, select [Quit] from the [File] menu.

Displays the shooting data.
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Starting ImageBrowser

● When the [Communication Settings] dialog box appears, select [USB Port] from the
[Port] list box and select the connected camera from the [Detected Camera] list
box. Then click the [Set] button.

● ImageBrowser can be started in the same way when a third-party card reader is
connected to the computer.

● To set up the software so that ImageBrowser does not start up when you connect
the camera to your computer, see “Disabling ImageBrowser Auto Start” (M-62).

Automatic Startup from the Auto Run
Dialog Box

In OS 9, you can set ImageBrowser to start up automatically from the [ImageBrowser
Automation wizard] dialog box that appears when you connect the camera to your computer.

1 Connect the camera to your computer. (M-9)
\ The [ImageBrowser Automation wizard] dialog box appears.

2 Confirm that [Display Images] radio button is selected and click
the [OK] button.
\ The Camera window and Browser

Window appear.
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Starting ImageBrowser

When ImageBrowser starts up automatically from the next
time onwards

The automatic processing settings selected previously are displayed in the [ImageBrowser
Automation wizard] dialog box. To use these settings unchanged, click the [Start] button. To do
nothing, click the [Cancel] button. To change the settings, click the [Settings change] button.

\ When you click the [Settings change] button, the window changes as shown below.

● When the [Display Images] radio button is selected, click the [OK] button.
\ The Camera window appears.
● When the [Download images] radio button is selected, click the [Next] button and

then proceed as instructed by the on-screen messages.
\ The images on the camera are downloaded.
● When you select the [Launch RemoteCapture] radio button, click the [OK] button.
\ RemoteCapture starts up. (M-48)
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Starting ImageBrowser

Disabling ImageBrowser Auto Start
In OS 9, use the procedure below to prevent ImageBrowser from starting up automatically
when you connect the camera to your computer.

1 Select the Apple menu s [Control Panels] s [Canon
ImageBrowser Auto Launch].
\ The [Settings for USB connection] dialog box appears.

2 Uncheck the [The application program below will start] checkbox.

3 Close the [Settings for USB connection] dialog box.
● Click [  ] in the upper left corner of the dialog box to close the dialog box.
\ ImageBrowser will cease to start automatically thereafter.
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Downloading and Saving Images
The procedure below describes how to download the images saved on a CF card in the
camera or card reader and save those images on your computer.

1 Display the images.
● Click the [CANON CAMERA]

button in the Browser Window.
\ The Camera window appears and

the images stored on the CF card
in the camera are displayed.

● When the [Communication Settings] dialog box appears, select [USB Port] from the
[Port] list box and select the connected camera from the [Detected Camera] list
box. Then click the [Set] button.

● You can also open the Camera window by clicking the [Canon Camera] icon in the
Folders area.

● To display images stored on the computer or on a CF card using a card reader,
click the [  ] to the left of the [EOS_DIGITAL] icon in the Folders area and then
double-click the [DCIM] icon that appears.

2 Select the image and click the [DOWNLOAD] button.
● Select the images to be downloaded by clicking the images.
● To select multiple images, hold down the <Shift> key as you click the images.
● Clicking a selected image again deselects that image.

\ The [Select Folder] dialog box appears.
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Downloading and Saving Images

3 Select the folder in which to save the images and click the
[Choose] button.
\ Image downloading begins and the

downloaded images appear in the
Browser Window.

● You can also download images to the computer by dragging them from the Camera
window and dropping them on the Browser area or Folders area.

● To disconnect the camera, select [Close] from the [File] menu in the Camera
window.
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Printing Images

1 Display images in the Browser window. (M-63)

2 Select the image(s) you wish to print in the Browser area.

3 Click the [PRINT] button and select [Layout printing] from the
displayed menu.
\ The [Layout Options] dialog box

appears.

4 Select a layout and click the [Next] button.
● Select the [Custom layout printing] radio button for the purposes of this example.
\ The page setup window in the [Layout Options] dialog box appears.

● Selecting the [Custom layout printing] radio button allows you to print your photos in
any position and at any size. By selecting other print modes, you can also print your
images as an index or in a tiled layout.

● If you are printing in OS 9 using a Canon printer that supports perforated paper, the
[Canon perforated paper printing] radio button is displayed allowing you to print on
Canon perforated paper.

● The settings available in step 4 vary depending on type of printing selected in step 3.

Select this option when you want
to set the custom image size and
position and create your own design.

Select this option to print as many
images as possible on a set paper
size (such as L-size or business-
card-size).

Prints the number of images
specified per page laid out so that
they cover the entire page.
(When a printer that supports
borderless full-screen printing is
used, [Borderless printing] is
displayed.)

Select this option to print the
images in an index format.

* The print mode settings vary depending on your printer.
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Printing Images

5 Click the [Page Setup] button.
● In the setup window that appears,

set parameters such as the paper
size and orientation and then close
the window.

\ The [Layout Options] dialog box
reappears.

6 Click the [OK] button.
\ The Print window appears.

7 Edit the Print window and click the [PRINT] button.
\ The Printer Setup dialog box appears.
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Printing Images

Displays the [Layout Options]
dialog box.

Displays the Printer Setup
dialog box.

Edit the Page Title
Open the [Edit] menu and
select [Edit Header].

Change the Image
Size
Drag the border to
resize the image.

Rotates the selected image.

Resets the layout.

Changes the default number of
images printed per page.

Print window
When the [Custom layout printing] radio button is selected in the [Layout Options] dialog box,
you can freely change the size and position of the images for printing.

● Saving the page layout
You can save the page layout as an “Album” by selecting [Save] from the [File] menu.

● Adding images to the page
You can drag and drop displayed images from the Browser window to the Print
window.

● Changing the image angle
Select the image and then click the [ROTATE] button. Then select [90 degrees right],
[90 degrees left] or [180 degrees] from the menu that appears.

Change the Layout
Drag the images to
change the layout.

Add Captions to Images
Click the image and then
select [Edit Caption] from
the [Edit] menu.

Add Text
Open the [Edit] menu and
select [Add Text].



M-68

Printing Images

● Changing the image size
You can change size of an image by moving the cursor over the image and dragging
the displayed arrows.

* Depending on the print mode, you may not be able to change image size or angle.

8 Select the printer to be used, specify the print settings and print
images.

Drag this arrow to change the image size.
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Printing Images

A check mark must be placed here to
automatically correct the image quality.

Select this option to automatically
correct images shot with Exif 2.2
compliant cameras and other images.

Select this option to automatically
correct only images shot with Exif 2.2
compliant cameras.

Adjusting the Image Quality and Printing
(Exif 2.2 compatible)

ImageBrowser includes an image quality adjustment function that is compatible with Exif 2.2
(Exif Print).
This function allows you to print images with the quality automatically corrected.

1 Select [Preferences] from the [ImageBrowser] menu.
● If you are using OS 9, select [Preferences] from the [Edit] menu.
\ The [Preferences] dialog box appears.

2 Select [Print] from the list box, make the settings of image quality
correction, and click the [OK] button.
\ The corrected values are applied and the dialog box closes.

3 Print images. (M-65)

● Images shot on camera that comply with Exif 2.2 incorporate recorded information
on the settings used when the shot was taken. The Exif Print correction functions
use this information to adjust the image quality so that it more accurately reflects
the shooting settings.

● When printing from ImageBrowser, the image quality adjustment settings are
applied for all images.
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Processing RAW Images and Merging Images
Processing RAW Images with ImageBrowser

To process RAW images from ImageBrowser, start up File Viewer Utility.

1 Display an image in the Browser window. (M-63)

2 Select the RAW image to be processed from the Browser area.

3 Click the [File] menu and select [RAW image processing].
\ File Viewer Utility starts, and the thumbnail-displayed RAW image is displayed in the

File Viewer Utility main window.

4 Process the RAW image.
● See “Processing RAW Images” (M-27) for information on how to process RAW

images.

If File Viewer Utility is started from ImageBrowser, the functions available in File
Viewer Utility are restricted. In addition to that [Show the folder tree] is not displayed,
the functions such as the camera settings, image rotation, image transfer, index
saving, image erasing, information update, image protection, etc. cannot be used.

Merging Images with PhotoStitch
PhotoStitch makes it easy to created composite images such as panorama shots by
automatically merging multiple images.

1 Display images in the Browser window. (M-63)

2 Select the desired JPEG images from the Browser area and then
select [PhotoStitch] in the [Edit] menu.
\ PhotoStitch starts up.
● Follow the instructions in the guidance window to merge the images.
● Please refer to the PhotoStitch Help menu for more details.

● You cannot merge RAW images in PhotoStitch.
● Up to four images can be merged using PhotoStitch.
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This chapter provides a troubleshooting manual and describes the
software uninstallation procedures.

Troubleshooting and
Uninstallation
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Troubleshooting
When the “Could not complete installation correctly”, “Communication between the camera
and computer failed” or “Software not running correctly” message appears, check the items
described below.

I have installed the software but the camera and
computer cannot communicate.

● Does your computer comply with these requirements?
➞ A Macintosh computer with a USB connector as a standard feature.

* Operation is not guaranteed when the camera is connected to a USB interface that is
not a standard feature of the computer.

● Are the camera and computer connected correctly?
➞ Connect the camera to your computer correctly using the dedicated USB cable. (M-9)

● Is the correct communication mode selected on the camera?
➞ To use the SOLUTION DISK software, set the camera’s communication mode to

[Normal]. If you are using the PTP function in OS X, set the mode to [PTP] (M-8).

● Is there sufficient charge left in the camera battery?
➞ Your computer does not supply power to the camera. Connect the DC Coupler Kit

(optional) to the camera or load a fully charged battery into the camera before
connecting it to your computer. (“Installing and Removing the Battery” in the Instructions
provided with your camera)

● Do you have more than one camera connected to your computer?
If you connect more than one camera to the same computer, the driver and camera may
not operate normally.

➞ Close the software and disconnect all the dedicated USB cables. Then reconnect just the
dedicated USB cable that connects the camera to your computer.

● Are you using the camera on a first-generation iMac without having first
updated the firmware?
Update the firmware using the iMac Firmware Update and then update the system software
to OS X or OS 9.
➞ You can download the iMac Firmware Update from Apple’s web site.
➞ Purchase OS X or OS 9 from your Apple retailer.

(* Version 10.2 of OS X and version 9.2 of OS 9 are recommended.)
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Troubleshooting

The software doesn’t run properly or doesn’t run at all.
● Is the preferences file for the software corrupted?

➞ The preferences file for your software may be damaged.
Quit all active programs, delete the [Canon CameraCom Pref] file and the preference
files for the software you are using from the [Preferences] folder, and then restart the
software.
If you are using OS X, double-click the startup disk and click the [Home] button. Then
double-click the [Library] folder s [Preferences] to open the [Preferences] folder and
delete the target preference files.
If you are using OS 9, open the [Preferences] folder by double-clicking [System Folder]
s the [Preferences] folder on the startup disk and then delete the target preference files.

• Canon CameraCom Pref Communications and default settings file shared by all
software programs

• CanonFileViewerUtility Pref Preferences file for File Viewer Utility

• RemoteCapture Pref Preferences file for RemoteCapture

• ImageBrowser Preferences Preferences file for ImageBrowser
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Uninstalling
● With the exception of ImageBrowser for OS 9, the software uninstallation procedure is the

same for both OS X and OS 9.
● Before beginning the software uninstallation, close all programs you are using and

disconnect the dedicated USB cable from your computer.
● When you have moved the software in the folders and control panels to be deleted to the

Trash, select [Empty Trash] from the [Finder] menu (If you are using OS 9, select [Empty
Trash] from the [Special] menu.) and empty the Trash. You cannot reinstall the software
until you have emptied the Trash.

Uninstalling (Deleting) the Software
The following explanation uses the procedures for uninstalling File Viewer Utility as an
example for uninstalling other programs as well.

1 Display the folder in which the software is saved.
● Open the [Canon Utilities] folder.

2 Drag the folder for the software to be uninstalled to the Trash and
empty the Trash.
● When uninstalling ImageBrowser for OS 9, you should also drag [Canon

ImageBrowser Auto Launch] from the [Control Panels] to the Trash and empty the
Trash.

● When you drag the folder to the Trash, take great care not to delete any important
images at the same time.

● When uninstallation ends, restart your computer.
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Uninstalling

Uninstalling Photoshop Elements 2.0

1 Display the folder in which the [Adobe Photoshop Elements 2]
folder is saved.

2 Drag the [Adobe Photoshop Elements 2] folder to the Trash and
empty the Trash.

● When you drag the folder to the Trash, take great care not to delete any important
images at the same time.

● When uninstallation ends, restart your computer.
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